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About This Book

This book provides detailed information on how to use each of the
services included with Netfinity Manager. For information on how
to install and configure Netfinity Manager, see Netfinity Manager
Quick Beginnings. For information on Netfinity Manager command
line interfaces, see the Netfinity Command Reference.

Who Should Read This Book

This book is for anyone who will be using the Netfinity Manager
and Services for local or remote hardware systems management. It
can also be used for quick reference by users of individual services.
However, detailed online helps are available for all Netfinity ser-
vices.

You should have general knowledge of your operating system,
network operations, and database functions.
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Starting Netfinity

To start Netfinity:

1. Open the Netfinity folder or program group.

During installation of Netfinity Manager, a Netfinity folder
(0S/2, Windows 95, or Windows NT 4.0 only) or a Netfinity
program group (Windows NT 3.51 only) was added to your
Desktop. The Netfinity folder or program group contains the

Netfinity Service Manager object.

| HetFinity - Icon View
Folder Edit ¥iew Selected Help

iz N

9

Metwork Driver C

o

WENENER  NetFinity Database Adrinistration

i

orfiguration  MefFinity Uninstall - MetFinity Darabase Tables  Read Me First

Figure 1. The Netfinity Folder

Notes:

a. In your Netfinity folder or program group is a document
titled Read Me First, which contains information about
Netfinity that might not be covered in your documentation.

b. The Netfinity folder also contains the Network Driver
Configuration object, which allows you to reconfigure your
network protocols and system keywords, and the Netfinity
Database Tables object, which contains a handy online
reference for all of the data tables in the Netfinity database.
For more information on Netfinity’s database support see
and Appendix I, “Netfinity Relational Database Tables” on
page 481 and “Netfinity Database Support” in Netfinity

Manager Quick Beginnings.

¢. The Netfinity folder also contains a Netfinity Database
Administration object. You can use Netfinity Database
Administration to configure Netfinity database support. For
more information on Database Administration, see “ODBC
Database Support” in Netfinity Manager Quick Beginnings
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2. Start the Netfinity Service Manager.

To start the Netfinity Service Manager, use mouse button 1 to
double-click on the Netfinity Service Manager object.

Netfinity Service Manager

All Netfinity services that are supported by your system can be
started from the Netfinity Service Manager window. The services
that are available for use depend on the installation configuration
you selected during installation.
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Figure 2. Netfinity Service Manager

To start any Netfinity service that appears in your Service Manager
window, double-click on the icon for that service. To start a
Netfinity service on a remote system, you must use the Remote
System Manager service. For more information on Remote System
Manager, see “Remote System Manager” on page 199.

2 Netfinity Manager



Netfinity Service Descriptions

Each Netfinity service consists of a base program and a graphical
user interface (GUI). The service base programs enable the
individual services to be accessed remotely by the Netfinity
Manager, but do not allow for local access. The service GUIs, when
functioning along with their respective base program, enable you to
access the service.

Some services are available only on systems with certain system
configurations. These services are:

e DMI Browser (requires DMI Service Layer)
e ECC Memory Setup (requires ECC memory)

¢ Predictive Failure Analysis (requires a PFA-enabled hard disk
drive)

¢ RAID Manager (requires a RAID hard disk drive subsystem)

e System Partition Access (requires a built-in System Partition)

Brief descriptions of each of the Netfinity services follow. Complete
instructions on how to use each of these services can be found in
the service-specific chapters of this book.

Alert Manager

The Alert Manager is an extendable facility that allows receiving
and processing of application-generated alerts. A variety of actions
can be taken in response to alerts, including logging alerts, notifying
the user, forwarding the alert to another system, executing a
program, playing a WAV file (available only on multimedia
systems), generating an SNMP alert message, dialing out to a digital
pager service (available only on systems that have a modem), or
taking an application-defined action. Actions are user-definable,
using a highly flexible action management interface.

Also, an extensive, detailed log is kept of all alerts received by the
Alert Manager. Logged information available from the log includes
date and time the alert was received, type and severity of the alert,
the ID of the application that generated the alert, as well as any text
that was generated and any action taken by the Alert Manager.

Starting Netfinity
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Individual or multiple alerts can be selected from the log and
printed for later reference, or deleted once problems are corrected.
This service is available for both stand-alone and network use.

Capacity Management

Capacity Management is an easy to use resource management and
planning tool for network managers and administrators, allowing
remote performance monitoring of every server on the network.

Cluster Manager

Cluster Manager is a powerful application designed to enhance the
cluster management capabilities of the Microsoft Cluster Server
(MSCS) administration console, included with Microsoft Windows
NT version 4.0 Enterprise Edition. Cluster Manager builds on the
power of MSCS, providing an integrated graphical interface that
enables you to quickly and easily monitor and manage the clustered
systems on your network. This service is available only on systems
running Windows NT Workstation 4.0.

Critical File Monitor

Critical File Monitor enables you to be warned whenever critical
system files on your system are deleted or altered. Critical File
Monitor makes it simple for you to generate Netfinity alerts when
an important System File (such as the CONFIG.SYS file) changes
date, time, size, or when it is deleted or created. Critical File
Monitor can also be used to monitor any other files that reside on a
Netfinity system.

DMI Browser

DMI Browser enables you to examine information about the
DMI-compliant hardware and software products installed in or
attached to your system.

ECC Memory Setup

The ECC Memory Setup allows for monitoring of ECC memory
single-bit errors, and can automatically “scrub,” or correct, the ECC
memory when errors are detected. Also, you can keep a running
count of single-bit errors, and can set a single-bit error threshold



that will cause a nonmaskable interrupt (NMI) if the ECC single-bit
error threshold is exceeded. This service is available for both
stand-alone and network use by any system that has ECC memory.

Event Scheduler

You can use Event Scheduler to automate many Netfinity services.
With Event Scheduler, you can automatically gather and export
System Information Tool, System Profile, and Software Inventory
data, distribute or delete files, restart systems, execute commands,
and access and manage System Partitions on all of the Netfinity
systems on your network. Scheduled events can be performed one
time only, or can be performed according to a user-defined
schedule.

File Transfer

You can use the File Transfer service to easily send, receive, or
delete files or entire directories to and from remote Netfinity
systems on your network.

Power-On Error Detect

The Power-On Error Detect service immediately warns you when a
remote Netfinity system has start-up problems, enabling you to
react quickly to problems and minimize downtime.

Predictive Failure Analysis

The Predictive Failure Analysis (PFA) service enables you to
continually monitor and manage PFA-enabled hard disk drives. A
PFA-enable hard disk drive features hardware designed to help
detect drive problems and predict drive failures before they occur,
thus enabling you to avoid data loss and system downtime.

Process Manager

You can use Process Manager to view detailed information about all
processes that are currently active on any system. You can also stop
or start processes and generate Netfinity alerts if a process starts,
stops, or fails to start within a specified amount of time after system
startup.

Starting Netfinity
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RAID Manager

The RAID Manager service enables you to monitor, manage, and
configure an assortment of Redundant Arrays of Independent Disk
(RAID) adapters and arrays without requiring you to take the RAID
system offline to perform maintenance. Use the RAID Manager to
gather data about your system’s RAID array and RAID adapter,
rebuild failing drives, add (or remove) logical drives, perform data
integrity tests, and many other RAID system tasks. This service is
available for both stand alone and network use by any system that
has a supported RAID adapter.

Remote Session

You can use Remote Session to establish a fully-active command
session with any remote Netfinity system.

Remote System Manager

You can use Remote System Manager to access and manage any
Netfinity service on any Netfinity system in your network. The
Netfinity systems on your network are organized into
easy-to-manage logical groups that can be updated automatically
using the auto-discovery feature.

Remote Workstation Control

Remote Workstation Control enables you to monitor or control the
screen display of a remote Netfinity system. Once you initiate a
Remote Workstation Control session with another Netfinity system,
you can passively monitor events that are occurring on the display
of the remote system or actively control the remote system’s
desktop. When you initiate an active Remote Workstation Control
session, all mouse clicks and keystroke entered on your system are
automatically passed through to the remote system. With Remote
Workstation Control, you can remotely start programs, open and
close windows, enter commands, and much more.

Screen View

The Screen View service takes a “snapshot” of any remote Netfinity
system’s graphic display and displays it on your screen. These
snapshots can then be saved as bitmaps and viewed later.



Security Manager

The Security Manager can prevent unauthorized access to some or
all of your Netfinity services. It uses incoming user ID and
password combinations, and is available for network use only.

Serial Connection Control

The Serial Connection Control service enables remote Netfinity
Managers to access your system through a phone line and modem.
With the Serial Connection Control service, you don't have to be
attached to a network to benefit from Netfinity’s outstanding remote
system access, monitoring, and management capabilities.

Note: Your system must have a properly installed and configured
modem that supports at least 9600 baud for the Serial
Connection Control service to function.

Service Configuration Manager

Service Configuration Manager enables you to save the
configuration of a Netfinity service from a selected system to a
service configuration file (SCF). Once created, SCF files can be used
by Event Scheduler to restore the configuration back to the same
system, or it can be used (in conjunction with the Event Scheduler)
to propagate that configuration on whatever other similar systems
you choose.

Service Processor Manager

Service Processor Manager enables you to configure and monitor
many features of your systemCluster Managers Advanced Systems
Management Adapter. This service enables you to dialout and
directly access and control a remote system’s Advanced Systems
Management Adapter. With Service Processor Manager you can
configure Advanced Systems Management Adapter events (such as
POST, loader, and O/S timeouts; critical temperature, voltage, and
tamper alerts; redundant power supply failures).

Software Inventory

Starting Netfinity
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Enables you to create and manage software product dictionaries that
can be used to easily maintain an inventory of all application
programs installed on your system.

System Diagnostics Manager

System Diagnostics Manager enables you to initiate a variety of
diagnostic tasks on systems that support ROM based diagnostics.
The results of all previously run diagnostic sessions are stored on
the system and can be examined using System Diagnostics Manager
to help diagnose and resolve system problems.

System Information Tool

The System Information Tool enables you to quickly and
conveniently access detailed information on the hardware and
software configurations of your system. System Information Tool
gathers information about almost any computer; however, the most
detail is provided when this service is used with IBM computers.
This service is available for both stand-alone and network use.

System Monitor

The System Monitor provides a convenient method of charting and
monitoring the activity of a number of components in a system,
including processor usage, disk space used, and ECC memory
errors. These convenient monitors are detachable and scalable,
enabling you to keep only the monitors you need available at all
times. You can use System Monitor’s Threshold Manager to set
threshold levels for any of the monitored components. When
exceeded, these thresholds will generate user-configured alerts.

Data is continually collected from the time the system starts. A
sophisticated data-handling technique is used to weigh the
individual values, average concurrent samples, and post single
values that accurately reflect long-term system activity. This
technique allows you to maintain system activity records without
creating enormous data files. This service is available for both
stand-alone and network use.



System Partition Access

The System Partition Access allows for greatly simplified System

Partition file handling, both locally and remotely. Individual files
and entire directories can be renamed or deleted from the System
Partition. Individual files can be renamed, deleted, or copied into
the System Partition. Also, the entire partition can be backed-up,
restored, or deleted. This service is available for both stand alone
and network use by any system that has a System Partition.

System Profile

The System Profile provides a convenient notebook of pertinent data
about a particular user or system. It features many predefined
fields for extensive user-specific data, including name, address,
office number and location, and phone number. System Profile also
includes many predefined fields for system-specific data that might
not be available to System Information Tool, including model and
serial numbers and date of purchase. Finally, there are many
user-definable “miscellaneous” fields that can be used to hold any
data the user or administrator requires.

Web Manager Configuration

You can use the Web Manager Configuration service to limit access
to the Netfinity Manager for Web to user-specified TCP/IP host or
ranges of TCP/IP host addresses. You can also enable or disable
the Netfinity Manager for Web and specify the TCP/IP port number
that the Netfinity web server functions on.

Delaying Netfinity Startup on OS/2 Systems

In some cases, it might be necessary for you to delay the automatic
startup of the Netfinity Network Interface (NETFBASE.EXE) in
order to allow other time-sensitive applications to start up correctly
or to allow your system to fully configure itself prior to beginning
network operations. NETFBASE.EXE includes a parameter (WAIT)
that enables you to specify the number of seconds that
NETFBASE.EXE will wait before starting.

Starting Netfinity
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During Netfinity installation, the Netfinity Network Interface object
is placed in the Startup folder. To configure Netfinity to wait a
specified number of seconds before starting:

1.
2.
3.

6.

Shut down the Netfinity Network Interface if it is running.
Open the Startup folder.

Using mouse button 2, click on the Netfinity Network Interface
object. This will open the Netfinity Network Interface context
menu.

Select Settings to open the Netfinity Network Interface Settings
notebook.

Type in the Parameters field
WAIT:x

where x is the number of seconds that you want the Netfinity
Network Interface to wait before starting.

Close the Netfinity Network Interface Settings notebook.

With the WAIT parameter set to X, whenever you start your system,
the Netfinity Network Interface will wait x seconds before starting.

Note: This feature is available only on systems that are running

0Ss72.



Alert Manager

Netfinity Alert Manager enables your system to receive and
automatically respond to alerts generated by other Netfinity
services. Using a variety of alert-specific information (including the
severity of the alert, the name of the Netfinity service that generated
the alert, the type of alert, and the network address of the system
that generated the alert), Netfinity alerts are categorized into alert
profiles. Profiles can be bound to one or more Alert Manager
actions (such as logging the alert or executing a command). Once a
profile is bound to an action, the action will be performed whenever
an alert that fits the profile is received.

Netfinity Alert Manager includes actions that do the following:

¢ Log the alert to a file

¢ Display the alert in a pop-up window

e Forward the alert to another workstation

e Execute a command

e Execute a minimized command

¢ Send a simple network management protocol (SNMP) version of the
alert (not available for local use on systems running Windows
3.1 or Windows 95.)

¢ Send a mapped SNMP version of the alert (similar to the
standard SNMP version of the alert, but featuring specific
Enterprise ID values for each of the various alert types; not
available for local use on systems running Windows 3.1 or
Windows 95)

¢ Play a waveform (WAV) sound file (requires multimedia
support)

¢ Send a message to a digital pager through a modem (requires
modem attached to system)

¢ Send the alert information to an alphanumeric pager through a
modem (requires modem attached to system)

¢ Send the alert to another user using TCP/IP SENDMAIL
(available only on systems running OS/2; requires TCP/IP for
0S/2 2.0 or later)

¢ Send an email version of the alert using Vendor Independent
Messaging (VIM) (requires VIM support)

¢ Send a messaging application programming interface (MAPI) version
of the alert (requires MAPI support)

e Export the alert information to a Netfinity database

© Copyright IBM Corp. 1994, 1998 11
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Export the alert information to a Lotus Notes database

Generate a Desktop Management Interface (DMI) event and
send it to the DMI Service Layer (requires DMI support)
Display the alert on PC Server 720 front panel (available only on
IBM PC Server 720 systems)

Add an error condition to the system (see “Error Conditions” on
page 222)

Remove the error condition from the system (see “Error
Conditions” on page 222)

Send the alert to mainframe applications such as NetView MVS
using APPC

Send the alert to a remote system using a serial connection

Add the alert to the Windows NT Event Log (available only on
systems running Windows NT)

Send a TCP/IP Web mail version of the alert, including links to
the Netfinity Web Manager interfaces, to another user using
TCP/IP SENDMAIL (available only on systems running OS/2;
requires TCP/IP for OS/2 2.0 or later)

Send an alert to FFST/2
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Note: Netfinity can be used to remotely manage Netfinity Manager,
Client Services for Netfinity Manager, or SystemView LAN
clients. However, these systems management products do
not support some of the features of the Netfinity Alert
Manager, including alert profiles. If you will be remotely
managing systems that are running any of these systems
management products, see Appendix A, “Alert Manager on
Downlevel Netfinity Systems” on page 446.

Alert Manager performs two essential systems management
functions:

1. Maintains a log of all received and logged alerts that can be
viewed with configurable filters.

The Alert Log lists all alerts that are currently recorded in the
Alert Log file. The Alert Log can be configured to display:

¢ All logged alerts

e Alerts that were received and logged within a specified time
or date range

¢ Alerts that were received and logged and that fit specified
alert profiles

e Alerts that were received within a specified time or date
range and that fit specified alert profiles.

Note: Only alerts that have been received and entered into the
Alert Log using the Add the alert to log file alert action
will appear in the Alerts in Log field. For information on
this and other alert actions, see “Netfinity Alert Actions”
on page 21.

For information on configuring the Alert Log views, see “Alert
Log Views” on page 17. For information on alert profiles, see
“Alert Profiles” on page 32.

2. Automatically responds to the alerts it receives with
user-specified actions.

You can use Alert Manager manager to select one or more alert
profiles and bind them to one of Alert Manager’ alert actions.
Once one or more profiles are bound to an alert action, this

Alert Manager
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action will automatically execute whenever an alert is received
that fits a profile to which it is bound. For information on alert
profiles, see “Alert Profiles” on page 32. For information on
binding alert profiles to alert actions, see “Binding Profiles to
Actions” on page 41.

Note: Netfinity can also be used to remotely manage Netfinity
Manager, client Services for Netfinity, or SystemView LAN
clients. However, these systems management products do
not support some of the features of the Netfinity Alert
Manager, including alert profiles. If you will be remotely
managing systems that are running any of these systems
management products, see Appendix A, “Alert Manager on
Downlevel Netfinity Systems” on page 446.

The Alert Log

The Alert Log window is the first window that you see when you
start the Alert Manager service. Any alerts that have been logged
using the Add alert to log file action, appear in the Alerts in Log
field in the bottom half of the Alert Log window.

Select an alert from the Alerts in Log to display information about
the alert in the upper half of the Alert Log window.

Note: You can select multiple alerts for the purposes of deleting
multiple files or printing reports, but only the currently
highlighted alert in the log will have its alert-specific
information displayed at the top of the screen.

Information displayed about the selected alert includes:

e Alert Text

e Type of Alert

e Severity

e Application ID

¢ Application Alert Type
e System Received From
e System Name

e Time of Alert

¢ Date of Alert

e System Unique ID



Alert Text

The Alert Text includes the name of the alert, as well as any textual
commentary included by the application that generated the alert.

Type of Alert

This is the application-specified alert type. A Type of Alert consists
of an alert sender ID followed by an alert type value. The alert
sender ID describes the nature of the device that generated the alert,
and the alert type value describes the content of the alert itself.

The possible alert sender IDs are;

e System

¢ DASD

¢ Network

¢ Operating System
¢ Application

e Device

e Security

An alert sender might also be unspecified, in which case an alert
sender ID will not be displayed.

The possible alert type values are:

¢ Failure

e Error

e Warning

¢ Information

An alert type can also be unspecified, in which case an alert type
value will not be displayed.

Severity

The alert Severity is a value from 0 to 7, with 0 being the most
severe. For example, an alert Severity of 0 could be assigned to a
disk failure, while a value of 7 could simply represent a system
going offline at the end of a day. Alert Severity is determined by
the application that generates the alert.

Alert Manager
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Application ID
The Application ID is the name of the application that sent the
specified alert to the log.

Application Alert Type

The Application Alert Type is a numeric value assigned to an
individual alert by the application that generated it. This value is
often used by the application that generated the alert.

Received From

The Received From value is the network address of the system that
generated the alert. The Received From value could be the local
system or a remote system that has been instructed to relay alerts to
the local error log.

System Name

The System Name value is the name of the system that generated
the alert. This name is specified by the user during Netfinity
installation.

Time of Alert

The Time of Alert is the time of day when the alert was generated
and logged.

Date of Alert

The Date of Alert is the calendar date on which the alert was
generated.

System Unique ID

The System Unique ID is a random 16 character identification string
that is assigned to the system when Netfinity is installed. It is
stored in the NFUNIQUE.ID file in the Netfinity directory of the
system that generated the alert. The System Unique ID is primarily
used for the identification and management of systems that
frequently change network addresses (such as when DHCP is used).



Alert Log Views

You can configure Alert Manager to filter the alerts that will be
visible in the Alerts in Log field. The current Alert Log View is
shown beside the Alert Log Views button. The available Alert Log
Views are:

Log shows all alerts

All alerts contained in the Alert Log are shown in the Alerts in
Log field.

Log is currently viewed by time

The alerts shown in the Alerts in Log field have occurred within
a specified time frame.

Log is currently viewed by profile

The alerts shown in the Alerts in Log field fit selected alert
profiles.

Log is currently viewed by time and profile

The alerts shown in the Alerts in Log fit selected alert profiles
and have occurred within a specified time frame.

Note: Only alerts that have been received and entered into the Alert

Log using the Add the alert to log file alert action will appear
in the Alerts in Log field. For information on this and other
alert actions, see “Netfinity Alert Actions” on page 21.

To change the Alert Log view:

1. Select Alert Log Views.

This opens the View Alert Log window (see Figure 4 on
page 18).

Alert Manager
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Figure 4. The View Alert Log window.

2. Enable (or disable) Alert Log view filters.
There are two Alert Log view filters:

¢ View by Time and Date
¢ View by Profiles

To enable the View by Time and Date filter:

a. Select the radio button that describes the time and date
range for alerts that will appear in the Alerts in Log field.
The available selections are:

e Last Hour

Only alerts logged in the last hour will appear in the
Alerts in Log field.

e Last (1—48) Hours

Only alerts logged within the number of hours that you
specify will appear in the Alerts in Log field.
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¢ Time Range

Only alerts logged within the time range specified in the
Start Time and End Time fields, on the date specified in
the Start Date field, will appear in the Alerts in Log
field.

e Date Range

Only alerts logged within the date range specified in the
Start Date and End Date fields will appear in the Alerts
in Log field.

b. Select Enable.
To enable the View by Profiles filter:

a. Select one or more alert profiles from the Inactive Profiles
field.

Select only the alert profiles that correspond to the alerts
that you want to appear in the Alerts in Log field.

b. Select Activate.

Selected alert profiles are removed from the Inactive
Profiles field and appear in the Active Profiles field.

c¢. Select and remove any unwanted alert profiles from the
Active Profiles field.

If there are any alert profiles contained in the Active
Profiles field, select them and then select Deactivate to
remove them from the Active Profiles field. They then
appear in the Inactive Profiles filed.

d. Select Enable.

Alert log entries that correspond to one or more of the selected
profiles will appear in the Alerts in Log field.

3. Select OK to save these changes and close the View Alert Log
window.

To close this window without saving any changes, select Cancel.

To disable the View by Time and Date filter or the View by Profiles
filter, deselect Enable in the filter’s button group.

Alert Manager



Alert Manager Functions

Alert Manager functions are activated from push buttons in the
Alert Manager window. These buttons are:

¢ Delete

e Print

e Print to File
¢ Profiles

¢ Refresh

e Actions

e Help

e Exit

Information on each of the Alert Manager functions follows.

Delete

Select Delete to delete any selected alerts from the Alert Log. To
use this function, select the alerts that you want to discard from the
Alert Log and select Delete.

Print

Select Print to print a hardcopy of all selected alerts (and all specific
alert information for the selected alerts) within the Alert Log.

Print to File

Select Print to File to save all selected alerts to a user-specified file.

Profiles

Select Profiles to configure, edit, or delete alert profiles. For
detailed instructions on how to create, edit, or delete profiles, see
“Alert Profiles” on page 32.

Refresh

Select Refresh to add any alerts that have been generated since the
Alert Log window was displayed.
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Actions

Select Actions to bind alert actions to any configured alert profiles.
Alert actions can also be configured to respond to individual alerts
that are not included in a Alert Manager alert profile. For
instructions on how to bind alert actions to alert profiles, see
“Binding Profiles to Actions” on page 41. For instructions on how
to configure an alert action to respond to an alert that is not part of
an alert profile, see “Binding Actions to Individual Alerts” on

page 43. For information on alert actions, see “Netfinity Alert
Actions.”

Help
Select Help to access the online help for Alert Manager. Detailed
information is available for all of Alert Manager’s functions.

Exit

Select Exit to exit Alert Manager.

Netfinity Alert Actions
Alert Manager includes alert actions that do the following:

e Add the alert to log file

Puts the alert into the Alert Log. This alert action does not
require that you provide additional information.
¢ Display the alert in a pop-up window

Displays a small window with all alert-specific information.
This alert action does not require that you provide additional
information.

e Forward the alert to another workstation

Sends the alert to another user over a specified network. Once
received, the alert is treated as though it were generated locally.
When configuring this action, you must specify the following
parameters:

Alert Manager
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Parameter Description

<P1>: Network Type
The network type that will be used to forward the
alert. The network type must be entered as
NETBIOS, TCPIP, IPX, SNA, or SERIPC (for serial
connections).

Note: To forward an alert to a remote system using
SERIPC (a serial connection), the serial
connection must be active. This alert action
will forward the alert to a remote system
using SERIPC only if a serial connection to the
remote system exists. To forward alerts to
remote systems using a serial connection that
is not currently active, use the “Send alert to
remote system through serial connection” alert
action.

<P2>: Network Address
The network type-specific address used by the
remote system to which the alert will be forwarded.

If you are unsure of the workstation’s network type or network
address, you can use Remote System Manager’s Edit System
action (see “Edit System” on page 219) or system group Detail
View (see “Detail View” on page 216) to check this information.

Execute a command

Executes a single command. When configuring this action, you
must specify the following parameter:

Parameter Description

<P1>: Command Line
The command that will be executed on the system.

This action includes special command strings (or macros) that
enable you to imbed alert-specific data in the command. This
data can then be used by the application that is started by the
command line. These macros are:



Macro
%TXT
%TIM
%DAT
%SEV
%SND
%TYP
%APP
%AT
%SYS
%P1-%P9

Imbedded Information

Alert text

Alert time

Alert date

Alert severity

Alert sender (for example, “NETBIOS::USER1")
Alert type

Alert application ID

Alert application-specific type

System Name

Alert-specific text strings that are imbedded in
the Alert Text. The content of these parameters
is dependent on the alert itself. For more
information, see Appendix J, “Netfinity Alerts”
on page 504.

Execute a minimized command

Executes a single, minimized command. When configuring this
action, you must specify the following parameter:

Parameter Description

<P1>: Command Line

The command that will be executed on the system.

This action includes special command strings (or macros) that
enable you to imbed alert-specific data in the command. This
data can then be used by the application that is started by the
command line. These macros are:

Macro
%TXT
%TIM
%DAT
%SEV

Imbedded Information
Alert text
Alert time
Alert date

Alert severity
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%SND Alert sender (for example, “NETBIOS::USER1”)

%TYP Alert type

%APP Alert application ID

%AT Alert application-specific type

%SYS System Name

%P1-%P9 Alert-specific text strings that are imbedded in

the Alert Text. The content of these parameters
is dependent on the alert itself. For more
information, see Appendix J, “Netfinity Alerts”
on page 504.

Send SNMP Alert through TCP/IP

Uses an SNMP agent to generate an SNMP version of the alert.
When configuring this action, you must specify the following
parameter:

Parameter Description

<P1>: Community String

The community string hame used by SNMP
applications in your network.

Notes:

1.

This action requires IBM TCP/IP for OS/2 version 2.0 or
later in an OS/2 environment.

This action is not available for local use on systems running
Windows 3.1 or Windows 95.

Netfinity’s management information base (MIB) file for use
with SNMP management applications is found on the
Netfinity CD in the SNMP_MIB directory. It is named
NETFIN.MIB. For information on how to use NETFIN.MIB
with your SNMP-based systems management software, see
the documentation that was supplied with your SNMP
agent or with your systems management product.

Netfinity’s management information base (MIB) file for use
with OS/2 SNMP management applications is found on the
Netfinity CD in the SNMP_MIB directory. It is named



MIB2.TBL. You can append this file to your existing
MIB2.TBL file, or replace your MIB2.TBL with this file.

Map Alert to SNMP Trap

Uses an SNMP agent to generate an SNMP trap featuring an
Enterprise OID value for use by SNMP-based management
applications. When configuring this action, you must specify
the following parameter:

Parameter Description

<P1>: Community String
The community string name used by SNMP
applications in your network.

Notes:

1. This action requires IBM TCP/IP for OS/2 version 2.0 or
later.

2. This action is not available for local use on systems running
Windows 3.1 or Windows 95.

3. Netfinity’s management information base (MIB) file for use
with SNMP management applications is found on the
Netfinity CD in the SNMP_MIB directory. It is named
NETFIN.MIB. For information on how to use NETFIN.MIB
with your SNMP-based systems management software, see
the documentation that was supplied with your SNMP
agent or with your systems management product.

4. Netfinity’s management information base (MIB) file for use
with OS/2 SNMP management applications is found on the
Netfinity CD in the SNMP_MIB directory. It is named
MIB2.TBL. You can append this file to your existing
MIB2.TBL file, or replace your MIB2.TBL with this file.

Play a WAV file (requires multimedia support)

Plays a specified waveform (WAYV) audio file in response to the
alert. When configuring this action, you must specify the
following parameter:
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Parameter Description

<P1>: Waveform file name
The fully-qualified filename of the waveform that
will be played in response to the alert.

Activate a numeric pager using a modem (requires a 100%
Hayes-compatible modem attached to the system)

Uses a modem attached to the system to dial out to a digital
pager service. After the modem connects to the pager service, it
will send all numeric data entered in the Digital Pager Display
field. If your digital pager service requires that you press the
pound sign (#) to send a page, be sure to type the # in the
Digital Pager Display field after the numeric data. When
configuring this action, you must specify the following
parameters:

Parameter Description

<P1>: Modem COM port
The COM port that the modem is configured to use.
The COM port must be entered as COMX, where X is
the number of the COM port.

<P2>: Pager number
The telephone number that will be dialed by the
modem to transmit the information to the pager.

<P3>: Digital pager display
The numeric data that will be displayed on the
pager.

Note: Depending on your paging service, you might need to
increase the amount of time that this alert action waits
after dialing the telephone number in filed <P2> before it
transmits the numeric data in field <P3>. To increase the
amount of time that will pass before the numeric data is
transmitted, add one or more commas (“,”) to the end of
the telephone number in field <P2>. Each comma will
cause the modem to wait two seconds before transmitting
the numeric data.



¢ Send alert to alphanumeric pager through TAP using a modem

(requires a 100% Hayes-compatible modem attached to the
system)

Uses a modem attached to the system to dial out to an
alphanumeric pager service. After the modem connects to the
alphanumeric pager service, it will send all alert information.

Parameter Description

<P1>: Modem COM port
The COM port that the modem is configured to use.
The COM port must be entered as COMX, where X is
the number of the COM port.

<P2>: TAP access number
The telephone number that will be dialed by the
modem to transmit the information to the pager.

<P3>: Pager ID
The identification number of the pager to which the
data will be sent.

<P4>: Additional text to send
Any additional text that you want to send along with
the alert data. This parameter is optional.

Notes:

1. This action will work only with pager services that use the
telocator alphanumeric protocol (TAP).

2. You must provide your pager’s Pager ID.

Send alert as TCP/IP mail (available only on systems running
0S/2; requires TCP/IP for OS/2 2.0 or later)

Uses the TCP/IP SENDMAIL program to send the Netfinity
alert as a note to a specified e-mail address. When configuring
this action, you must specify the following parameters:

Parameter Description

<P1>: Target user ID
The TCP/IP ID of the system to which the alert will
be sent.
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<P2>: Target host address
The TCP/IP host address of the target user’s system.

Send alert as TCP/IP Web mail (available only on systems
running OS/2; requires TCP/IP for OS/2 2.0 or later)

Uses the TCP/IP SENDMAIL program to send the Netfinity
alert as a note to a specified e-mail address. The alert text will
be in HTML format. When configuring this action, you must
specify the following parameters:

Parameter Description

<P1>: Target user ID
The TCP/IP ID of the system to which the alert will
be sent.

<P2>: Target host address
The TCP/IP host address of the target user’s system.

Send to E-Mail via VIM interface (requires VIM support)

Uses the Vendor Independent Messaging (VIM) interface to
generate a VIM-version of the alert that can be sent to any
properly configured system that is 32-bit VIM-compliant, such
as Lotus Notes.

The requirements for a system running Lotus Notes are identical
to the requirements for a system to export data to a Lotus Notes
database. For more information, see see “Lotus Notes Database
Support” in Netfinity Manager Quick Beginnings.

When configuring this action, you must specify the following
parameters:
Parameter Description

<P1>: Mail System Password
The password that must be used to enable access to
the VIM mail system.

<P2>: E-Mail Address
The email address of the system to which the alert
information will be sent.

¢ Send to E-Mail via MAPI interface (requires MAPI support)



Uses the MAPI interface to generate a MAPI-version of the alert
that can be sent to any system that is MAPI-compliant. When
configuring this action, you must specify the following
parameters:

Parameter Description

<P1>: Mail System Password
The password that must be used to enable access to
the VIM mail system.

<P2>: E-Mail Address
The email address of the system to which the alert
information will be sent.

<P3>: Profile Name
Some MAPI-compliant applications require a Profile
Name to properly process MAPI data. If the
MAPI-compliant application to which this alert will
be sent requires a Profile Name, type it in this field.
If your MAPI-compliant application does not require
a Profile Name, leave this field blank.

Export to a Netfinity database

Exports the alert information to a selected Netfinity DB2 or
ODBC database. When configuring this action, you must
specify the following parameters:

Parameter Description

<P1>: Database Name
The name of the Netfinity database to which the data
will be exported.

<P2>: User ID
The ID that, when combined with a password, will
enable access to the specified database.

<P3>: Password
The password that, when combined with a user ID,
will enable access to the specified database.

Export to a Lotus Notes database
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Exports the alert information to a selected Lotus Notes database.
When configuring this action, you must specify the following
parameters:

Parameter Description

<P1>: Lotus Notes Password
The password that will give you access to the Lotus
Notes database server.

<P2>: Lotus Notes Server Name
The name of the Lotus Notes database server to
which the data will be exported.

Send DMI Event through DMI Service Layer (requires DMI
support)

Converts the alert into a DMI event, which is then forwarded to
the DMI Service Layer. Once it is received by the DMI Service
Layer, it can be used by other DMI-compliant management
applications. This alert action does not require that you provide
additional information.

Display on PC Server 720 Front Panel (available only on IBM PC
Server 720 systems)

Displays the alert-specific information on the PC Server 720’s
front panel LED screen. This alert action does not require that
you provide additional information.

Set error condition for sending system

Adds an Error Condition to the system’s Error Condition log.
When configuring this action, you must specify the following
parameter:

Parameter Description

<P1>: Error Condition
The name that will be used to identify this error
condition in the Error Condition log.

A system’s Error Condition log is accessed with the Remote
System Manager. For more information on Error Conditions,
see “Error Conditions” on page 222.

Clear error condition for sending system



Removes a previously generated Error Condition from the
system’s Error Condition log. When configuring this action, you
must specify the following parameter:

Parameter Description

<P1>: Error Condition
The name of the error condition that will be removed
from the Error Condition log.

A system’s Error Condition log is accessed with the Remote
System Manager. For more information on Error Conditions,
see “Error Conditions” on page 222.

Send alert to remote system through serial connection

Uses a previously defined serial connection to send the alert to a
Netfinity system that can be accessed using Netfinity’s Serial
Connection Control service (see “Serial Connection Control” on
page 253). When configuring this action, you must specify the
following parameter:

Parameter Description

<P1>: Connection Name
The name of serial connection as defined in Serial
Connection Control.

Send alert to host via APPC

Converts the Netfinity alert to a network management vector
transport (NMVT) alert for use by host-based management
applications (such as NetView for MVS). This alert action does
not require that you provide additional information.

Notes:

The NMVT.INI file, found in the Netfinity directory,
contains alert descriptions that map standard Netfinity alerts
to NMVT-style alerts that can then be properly passed to a
host system using APPC and the “Send alert to host via
APPC” alert action. If you define new Netfinity alerts
(using, for example, Netfinity’s GENALERT command), you
must make changes to this file for the alerts to be converted
properly. For more information, see “Adding GENALERT
Alert Descriptions to the NMVT.INI File” on page 468.
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¢ Add event to Windows NT Event Log (available only on
systems running Windows NT)

This action adds information about the alert to the Windows NT
Event Log. This alert action does not require that you provide
additional information.

e Forward alert to FFST/2 (available only on systems running
085/2)

This action sends a version of the Netfinity alert to FFST/2.
This alert action does not require that you provide additional
information.

Alert Profiles

Alert profiles are simple filters that enable you to better manage
alerts received by your system. Using alert-specific information a
profile describes a class, or set of classes, of alerts. With alert
profiles you can classify alerts by service or application, by
responsible person, or simply by urgency. Alert profiles can be
bound to Alert Manager actions, enabling you to react automatically
to alerts generated by Netfinity systems in your network. Alert
profiles can also be used to filter the type of alerts that are shown in
the Alert Log (see “Alert Log Views” on page 17).

Netfinity Alert Manager comes with many predefined alert profiles
that will meet the needs of most users. Using these predefined alert
profiles, you will be able to quickly and easily configure Alert
Manager to respond and react to received alerts automatically. See
“Predefined Alert Profiles” on page 37 for more information on
Netfinity’s predefined alert profiles.

Select Profiles from the Alert Log window to open the Alert Profiles
window (see Figure 5 on page 33). The Alert Profiles window
displays a list of all available profiles. You can select individual
profiles for editing or deleting, or create completely new profiles.

e To create a new alert profile, see “Creating New Alert Profiles”
on page 33.

e To edit an alert profile, see “Editing Alert Profiles” on page 37.



¢ To delete an alert profile, see “Deleting Alert Profiles” on

page 37.
07 _Alert Profiles - Mysystem [
Profile List
Logical RAID Device Critical Alerts j

Logical RAID Device Offline Alerts
Logical RAID Device Online Alerts
Physical RAID Drive Dead Alerts
Physical RAID Drive Online Alerts
Physical RAID Drive PFA Alerts
Physical RAID Drive Standby Alerts
Power-0n Error Detect Error Alerts
Power-On Error Detect Info Alerts
Predictive Failure Analysis Alerts
Process Failed to Start Alerts
Process Started Alerts

Process Terminated Alerts

=i [T |

|_Edit_ || Mew || Delete || Help || Done |

Figure 5. The Alert Profiles window.

Creating New Alert Profiles
To create a new alert profile:

1. Select New.

This opens the Profile Editor window (see Figure 6 on page 34).
Use the Profile Editor to specify the alert-specific information

(called alert conditions) that will determine whether a received
alert fits the alert profile.
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fOY Profile Editor - My System ol o

Define By... Options

~Alert Conditions:

rAlert Type: ——— X -Severity: Application ID:
[Z1 Any Alert Type [ Any [-1 Any
Unknown Bl 0 |4
Failure H 1 B
Error 2
Warning - 3 |

~Application Alert Type: Sender ID:
[ Any I ¥ Any Sender I

15

900 | [

~Current Profile:

Profile Hame:
|Access Granted Alerts

Help |

| Save | | Cancel

Figure 6. The Profile Editor window.

2. Set the Alert Conditions

When creating an alert profile action, you must first specify the
alert conditions that must be met for the received alert to fit a
specific alert profile. As alerts are received, the Alert Manager
checks each of these conditions to see if they meet the
specifications for a defined alert profile. If all alert conditions
are met, the alert fits the alert profile. If an alert fits an alert
profile, any actions that are bound to that profile will be
executed. For instructions on how to bind alert actions to alert
profiles, see “Binding Profiles to Actions” on page 41.

There are five alert conditions that are used by the Alert
Manager to determine whether an alert fits an alert profile. For
an alert to fit an alert profile, it must meet all of the alert
conditions for the action. These five alert conditions are:

e Alert Type
e Severity
e Application ID



¢ Application Alert Type
e Sender ID

To specify the alert conditions for this alert profile:
a. Select an Alert Type.

The Alert Type is a brief description of the generated alert.
It describes the nature of the alert (unknown, failure, error,
warning, information), and can also contain a general
description of the source of the alert (system, disk, network,
operating system, application, device, or security).

To check incoming alerts for specific Alert Types, select one
or more Alert Types from the selection list. If you do not
want to check for specific Alert Types, select the Any check
box above the selection list.

b. Select a Severity.

The Severity is a number from 0 through 7 that indicates
how serious a generated alert is. A severity of 0 represents
a very serious alert, while a severity of 7 is relatively minor.

To check incoming alerts for specific Severity values, select
one or more Severity values from the selection list. If you
do not want to screen for specific Severity values, select the
Any check box above the selection list.

c. Select an Application ID.

The Application ID is the alphanumeric identifier of the
application that generated the alert.

To check incoming alerts for specific Application 1Ds, you
can choose one or more from the Application ID selection
list. If an Application ID that you require is not available
from the list, you can add it to the list by typing the ID in
the entry field above the selection list and pressing Enter. If
you do not want to check for specific Application IDs, select
the Any check box above the selection list.
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d. Select an Application Alert Type.

The Application Alert Type is a numeric value assigned to
an individual alert by the application that generated it. This
value is often used by the application itself.

To check incoming alerts for specific Application Alert
Types, you can choose one or more from the Application
Alert Type selection list. If an Application Alert Type that
you require is not available from the list, you can add it to
the list by typing it in the entry field above the selection list
and pressing Enter. If you do not want to check for specific
Application Alert Types, select the Any check box above the
selection list.

e. Select a Sender ID.

The Sender ID is the network address of the system that
generated the alert.

To check incoming alerts for specific Sender IDs, you can
choose one or more from the Sender ID selection list. If a
Sender ID that you require is not available from the list, you
can add it to the list by typing it in the entry field above the
selection list and pressing Enter. If you do not want to
check for specific Sender IDs, select the Any check box
above the selection list.

3. Name the alert profile.

This is the name that will appear in the Alert Profile window
Profile List field. Type in the Profile Name field a name for the
Alert Profile. This name can be up to 64 characters long.

4. Save the Alert Profile.
Select Save to save the Alert Profile. This Alert Profile will now
appear in the Alert Profile window Profile List field.

Select Cancel to close this window without saving any alert profile
information.



Editing Alert Profiles

To edit a previously defined alert profile:

1. Select from the Profile List the name of the alert profile you
want to edit.

2. Select Edit.
This opens the Profile Editor window (see Figure 6 on page 34).
3. Change alert conditions, if necessary.

If you are editing this alert profile to alter the alert conditions
that must be met for the received alert to fit the alert profile,
select the appropriate new Alert Type, Severity, Application ID,
Application Alert Type, or Sender ID values as necessary.

4. Change the profile name, if necessary.

If you want to rename this alert profile, type in the Profile
Name field the new profile name.

5. Save this alert profile.
Select Save to save the changes you've made to this alert profile.

Select Cancel to close this window without changing any alert
profile information.

Deleting Alert Profiles
To delete an alert profile, select an alert profile from the Profile List
field, and then select Delete.

Predefined Alert Profiles

Alert Manager includes many predefined alert profiles. A list of
predefined alert profiles that will be installed on all Netfinity
systems, and a brief description nature of the alert-specific
information that fits the profile, follows:

Profile Name Alert Description

Power-On Error Detect Error Alerts
POST error detected by Power-On Error Detect
on a Netfinity system.

Alert Manager

37



38

Netfinity Manager

Power-On Error Detect Information Alerts
System Partition access during startup detected
by Power-On Error Detect on a Netfinity
system.

Predictive Failure Analysis Alerts
Imminent failure of a PFA-enabled hard disk
drive reported by Predictive Failure Analysis.

File Changed Alerts
Critical File Monitor detected that a monitored
file has been changed.

File Deleted Alerts Critical File Monitor detected that a monitored
file has been deleted.

File Created Alerts Critical File Monitor detected that a monitored
file has been created.

Process Terminated Alerts
Process Manager detected that a monitored
process has ended.

Process Started Alerts
Process Manager detected that a monitored
process has started.

Process Failed to Start Alerts
Process Manager detected that a monitored
process has failed to start.

System Online Alerts
Remote System Manager has reported that a
specific remote system is online and functional.

System Offline Alerts
Remote System Manager has reported that a
specific remote system is offline or
unreachable.

Access Granted Alerts
Security Manager allowed a remote user that
provided a User ID/Password combination
access to the system.



Public Access Granted Alerts
Security Manager has allowed a remote user
Public access to the system.

System Access Denied Alerts
Security Manager has denied a remote user
access to the system.

System Restart Initiated Alerts
Security Manager has detected and permitted a
system restart request by a remote user.

System Restart Rejected Alerts
Security Manager has detected and rejected a
system restart request by a remote user.

Service Start Request Alerts
Service Manager has allowed use of a Netfinity
service by a remote user.

Service Start Rejected Alerts
Service Manager has denied use of a Netfinity
service by a remote user.

Threshold Error Alerts
A System Monitor error threshold condition
has been met.

Threshold Warning Alerts
A System Monitor warning threshold condition
has been met.

Threshold Return to Normal Alerts
A previously registered System Monitor
warning or error threshold condition has
returned to normal.

Physical RAID Device Online Alerts
A physical RAID device attached to the system
has changed state to Online.

Physical RAID Device Standby Alerts
A physical RAID device attached to the system
has changed state to Standby.
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Physical RAID Device Dead Alerts
A physical RAID device attached to the system
has changed state to Dead.

Logical RAID Device Online Alerts
A logical RAID device attached to the system
has changed state to Online.

Logical RAID Device Critical Alerts
A logical RAID device attached to the system
has changed state to Critical.

Logical RAID Device Offline Alerts
A logical RAID device attached to the system
has changed state to Offline.

Physical RAID Drive PFA Alerts
A physical RAID device attached to the system
has reported the imminent failure of a
PFA-enabled hard disk drive in the RAID
array.

Severity 0 Alerts A severity 0 alert has been received.

Severity 1 Alerts A severity 1 alert has been received.

Severity 2 Alerts A severity 2 alert has been received.
Severity 3 Alerts A severity 3 alert has been received.

Severity 4 Alerts A severity 4 alert has been received.

Severity 5 Alerts A severity 5 alert has been received.
Severity 6 Alerts A severity 6 alert has been received.
Severity 7 Alerts A severity 7 alert has been received.

All Alerts An alert has been received.

Many additional alert profiles will be installed if your system uses

specific software or communications products (such as
Communications Manager or LAN Server).

To create new alert profiles, see “Creating New Alert Profiles” on

page 33. To edit an existing alert profile, see “Editing Alert
Profiles” on page 37.
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Binding Profiles to Actions

To enable Alert Manager to automatically respond to received alerts,
you must bind alert profiles to alert actions. Once an alert profile is
bound to an alert action, the alert action will be performed
automatically whenever Alert Manager receives an alert that fits the
profile. Multiple profiles can be bound to individual alert actions,
and an individual alert profile can be bound to multiple alert

actions.
To bind an alert profile to an alert action:

1. Select Actions from the Alert Log window.

This opens the Alert Action window (see Figure 7). This
window contains a list of all currently configured alert actions.

F0% Alert Actions - My System o o

Available Actions:

Add alert to log file

T =
| Edit || Hew | | Delete | | Help | | Done |

Figure 7. The Alert Actions window.

2. Select New.

This opens the Action Editor window (see Figure 8 on
page 42).
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FOY Action Editor - My System ol o

Bind To... Opfions

~Alert Conditions:
~Alert Type:

Severity: Application ID:

[ Any [ Any |

~Application Alert Type: Sender ID:
[+ Any I [+ Any Sender |

15 - B
900

40 =+ []

~Action Definition:
Action: INutifg user with pop-up =l

Save I Cancel I Help I

Figure 8. The Action Editor window.

3. Select Profiles from the Bind To... pull-down menu. This
switches the Action Editor window to the Profiles view.

4. Bind one or more alert profiles to an alert action.

To bind alert profiles to an alert action, you must first select the
profiles that will trigger the action, and then select the alert
action and provide any necessary defining information.

a. Select one or more alert profiles to bind to an action.

All currently available and unused alert profiles are listed in
the Other Profiles field. Select one or more alert profiles
from this list, and then select Trigger By. All selected
profiles will then appear in the Triggering Profiles field.
Received alerts that fit any of the profiles listed in the
Triggering Profiles field will cause Alert Manager manager
to perform an alert action.

Note: To remove alert profiles from the Triggering Profiles
field, select the profiles that you want to remove and



then select Do Not Trigger By. Selected profiles are
then moved to the Other Profiles field.

b. Select an alert action.

Use the spin buttons at the right of the Action field to see
the available alert actions.

c. Enter additional information, if necessary.

Some alert actions will require you to provide additional
information (to whom alerts should be sent, what command
to execute, and so on). If additional information is required,
the parameter will be displayed in the Action field group as
<P#>, where # is the number of the parameter. An Action
Definition parameter field appears for each required
parameter, along with a brief description of the information
that is required. Enter the necessary information in each
field.

5. Label this action.

Type in the Action Label field a brief description of this alert
profile and alert action combination. This description can be up
to 32 characters. When you finish binding the alert profiles and
the alert action, the Action Label will appear before the name
alert action in the Available Actions field in the Alert Actions
window.

6. Finish binding the alert profiles to the selected alert action.

Select Save to finish binding the alert profiles to the selected
action. The Action Editor window will close, and the Action
Label, followed by the name of the alert action that you selected,
appears in the Available Actions field in the Alert Actions
window.

Select Cancel to close this window without saving any information.

Binding Actions to Individual Alerts

To enable Alert Manager to automatically respond to individual
alerts that are not part of a defined Alert Profile, you must bind the
desired action to specific specific alert conditions. Once an alert
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profile is bound to specific alert conditions, the alert action will be
performed automatically whenever Alert Manager receives an alert
that contains all of the specified conditions.

Configuring an action is a two-step process. First, you must set the
Alert Conditions that Alert Manager will look for. Then, you must
set an Action Definition to define what action the Alert Manager
will take in response to the received alert. Detailed descriptions of
this process follow.

1. Select Actions from the Alert Log window.

This opens the Alert Action window (see Figure 7 on page 41).
This window contains a list of all currently configured alert
actions.

2. Select New from the Alert Actions window.

This opens the Action Editor window.
3. Select Alert Conditions from the Bind To... pull-down menu.
4. Set the Alert Conditions

When defining an action, you must first specify the Alert
Conditions that must be met for the Alert Manager to execute a
defined action. As alerts are received, the Alert Manager checks
each of these conditions to see if they meet the specifications for
a defined action. If all Alert Conditions are met, the defined
action is executed.

There are five Alert Conditions that are used by the Alert
Manager to determine appropriate action responses. For an
alert to trigger an action, the alert must meet all of the alert
conditions for the action. These five alert conditions are:

e Alert Type

e Severity

e Application ID

e Application Alert Type
e Sender ID

To specify the Alert Conditions:
a. Select an Alert Type.



The Alert Type is a brief description of the generated alert.
It describes the nature of the alert (unknown, failure, error,
warning, information), and can also contain a general
description of the source of the alert (system, disk, network,
operating system, application, device, or security).

To screen incoming alerts for specific Alert Types, select one
or more Alert Types from the selection list. If you do not
want to screen for specific Alert Types, select the Any check
box above the selection list.

. Select a Severity.

The Severity is a number from 0 through 7 that indicates
how serious a generated alert is. A severity of 0 represents
a very serious alert, while a severity of 7 is relatively minor.

To screen incoming alerts for specific Severity values, select
one or more Severity values from the selection list. If you
do not want to screen for specific Severity values, select the
Any check box above the selection list.

. Select an Application ID.

The Application ID is the alphanumeric identifier of the
application that generated the alert.

To screen incoming alerts for specific Application IDs, you
can choose one or more from the Application ID selection
list. If an Application ID that you require is not available
from the list, you can add it to the list by entering the ID in
the entry field above the selection list and pressing Enter. If
you do not want to screen for specific Application IDs,
select the Any check box above the selection list.

. Select an Application Alert Type.

The Application Alert Type is a numeric value assigned to
an individual alert by the application that generated it. This
value is often used by the application itself.

To screen incoming alerts for specific Application Alert
Types, you can choose one or more from the Application
Alert Type selection list. If an Application Alert Type that
you require is not available from the list, you can add it to
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the list by entering it in the entry field above the selection
list and pressing Enter. If you do not want to screen for
specific Application Alert Types, select the Any check box
above the selection list.

e. Select a Sender ID.

The Sender ID is the network address of the system that
generated the alert.

To screen incoming alerts for specific Sender 1Ds, you can
choose one or more from the Sender ID selection list. If a
Sender ID that you require is not available from the list, you
can add it to the list by entering it in the entry field above
the selection list and pressing Enter. If you do not want to
screen for specific Sender IDs, select the Any check box
above the selection list.

5. Set an Action Definition.

You must select a specific action, and supply any necessary
information for the completion of the action.

a. Select an Action.

An action is a program that is executed in response to an
alert that meets the Alert Conditions that you have
specified. Use the spin buttons at the right of the Action
field to see the available action handlers.

b. Enter additional information, if necessary.

If additional information is required, the parameter will be
displayed in the Action field as <P#>, where # is the
number of the parameter. An Action Definition parameter
field appears for each required parameter, along with a brief
description of the information that is required. Enter the
appropriate information in each field.

6. Save the defined action.

Once all Alert Conditions and Action Definition information has
been entered, select Save to save the configured action. This
action will now appear in the Available Actions field of the
Alert Actions window. After you select Save, the Action Editor
window closes automatically.



Remotely Managing Downlevel Netfinity
Systems

If you are using Netfinity Alert Manager to remotely manage
systems that are using downlevel Netfinity Manager, Client Services
for Netfinity Manager, or SystemView LAN clients, you will not be
able to bind alert profiles to alert actions. If you will be remotely
managing systems that are running any of these systems
management products, you must configure each alert action to
respond specifically to a specified alert conditions. For more
information on how to remotely manage systems that are running
these products, see Appendix A, “Alert Manager on Downlevel
Netfinity Systems” on page 446.

Receiving Alerts from First Failure Support
Technology (FFST)

If your system is running OS/2 Warp version 3.0 or later and you
use Warp’s built-in First Failure Support Technology (FFST) to track
problems with other products, you can enable Netfinity to receive
any FFST information and convert the FFST trap into a Netfinity
alert. If FFST is enabled on your system you will be asked during
installation whether you want FFST trap information to be
forwarded to Netfinity Alert Manager. Select Yes to enable this
feature. Once this feature is enabled, FFST trap information will be
converted automatically into Netfinity alerts. Also, systems that
have FFST installed will also have additional alert profiles available
that are specifically designed to work with a variety of
FFST-enabled products (such as IBM Communication Manager or
LAN Server).
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Use the Alert on LAN configuration service to configure monitoring
options of Alert on LAN-capable systems locally and remotely.
Systems with Alert on LAN capability provide critical status
information about system states. The data is reported by hardware
or software (depending upon whether the systems in currently
powered on or not) using TCP/IP. Some of the status information
that is reported includes:

missing processors
chassis intrusion
broken LAN connections
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Figure 9. The Alert on LAN Configuration service.

For Alert on LAN to function properly, you must configure the
following options:

Description

Alert on LAN enable status Use this option to enable or disable all

Alert on LAN capabilities on the system you are
configuring

© Copyright IBM Corp. 1994, 1998



Netfinity Manager IP Address Enter the IP address of a system
running Netfinity Manager. All Alert on LAN data on
the system you are configuring will report data to this IP
address.

Netfinity Manager Port Number Enter the port number of the
system running Netfinity Manager at the IP address you
entered in the Netfinity Manager IP Address field. All
Alert on LAN data on the system you are configuring
will report data to this port number.

Heartbeat Timer Use the values available in this field to set the time
interval at which Alert on LAN will send out a heartbeat
message to the Netfinity Manager at the IP address
specified in the Netfinity Manager IP Address field. If
the message fails to be sent, the Netfinity Manager will
send out an alert.

Note: This interval must be a multiple of 43 seconds.

Watchdog Timer Use the values available in this field to set the
time interval at which Alert on LAN will send out an
alert if the operating system experiences a crash.

Note: This interval must be a multiple of 86 seconds.

Retransmission Timer Use the values available in this field to set
the time interval at which Alert on LAN will send
message packets for each alert sent out.

Note: These alerts are sent out at multiples of 3 seconds.

Agent Polling Period Use the values available in this field to
configure the time interval at which Alert on LAN
software checks the status of hardware.

Monitor Events Enable/Disable individual events Alert on LAN is
capable of monitoring.
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Capacity Management is an easy-to-use resource-management and
planning tool for network managers and administrators, allowing
remote performance monitoring of every server on the network.

IBM Capacity Management identifies potential bottlenecks in a
network, allowing for effective planning of future capacity needs,
such as microprocessor, disk, or memory upgrades, thus preventing
network slow downs and downtime. With Capacity Management
you can intelligently plan for future hardware upgrades and how
best to spend your resource dollars.

Capacity Management includes extensive online help, including
online tours. The online tours are interactive helps that guide you
through Capacity Management’s functions, making it especially
simple to learn and understand this service. To use an online tour,
select Tour the Generator, Tour the Scheduler, or Tour the Viewer
from the Capacity Management window (see Figure 10).

®g Capacity Manager ==

Generate a report now, while you wait.
Tour the Generator |

.

Generate

A

Schedule reports to be generated later.
Tour the Scheduler |
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View existing reports. _
Taur the Viewer |

Wiew

Done | Help |

Figure 10. The Capacity Management window

Note: The Capacity Management interface is available for use only
on systems running Windows NT. However, data can be
collected from any remote systems running Client Services for
Netfinity Manager for OS/2, Windows 95, Windows NT, or
NetWare.
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Generating Reports
To generate a new Capacity Management report:
1. Select Generate from the Capacity Management window.

This opens the Generate Reports notebook. Initially, the
notebook opens to the Overview page. This page provides brief
step-by-step instructions on generating reports. When you are
ready to begin generating a report, select Next. This will open
the Generate Reports notebook to the Report Definition page
(see Figure 11).
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Figure 11. Report Generator notebook — Report Definitions page

2. Select a Report Definition.

The Report Definitions page of the Generate Reports notebook
contains all previously defined Report Definitions. Report
Definitions specify the data that is collected for a Capacity
Management report. You can:

e Select a previously defined Report Definition

Capacity Management
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To select a previously defined Report Definition, select the
Report Definition and then select Next. This opens the
Generate Reports notebook to the Systems page. If you are
using a previously created report, go to step 4 on page 53.

e Edit a previously defined Report Definition

To edit a previously defined Report Definition, select the
Report Definition and then select Edit. This opens the
Report Definition window (see Figure 12).

e Create a new Report Definition
To create a new Report Definition, select New. This opens
the Report Definition window (see Figure 12).
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Figure 12. Report Definition window

3. Create (or edit) the Report Definition.

Use the selections available on the Report Definitions window to
configure the Report Definition. You will need to specify:

¢ The time period for which data will be collected (Duration)

e The amount of data to collect (Global Sampling Frequency)
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e The days on which the data will be collected (Days)

¢ The specific monitored data that will be included in the
report (Monitors to include ub the report)

Select Next to continue.

4. Select systems to include in the report.
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Figure 13. Report Generator notebook — Systems page

Select Netfinity groups or systems that will be included in the

report. Then, select Next to open the Report Generator
notebook to the Generate page (see Figure 14 on page 54).
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Figure 14. Report Generator notebook — Generate page

5. Name the report, and specify a Report Generation timeout

interval.

You must provide a name for your report. Report Generation
timeout interval specifies the amount of time Capacity
Management will attempt to collect data from any system you
specified in your Report Definition. If the timeout interval is
exceeded without Capacity Management having successfully
collected any data from the system, Capacity Management will
ignore the system and continue generating the report using the
other selected systems.

. Select Generate to generate the Capacity Management report.

Capacity Management will immediately begin compiling the
report based on your Report Definition. When the report is
complete, it is displayed in the Report Viewer window.
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Figure 15. The Report Viewer window

Scheduling Reports

You can use Capacity Management to automatically gather data and
create reports. Select Schedule from the Capacity Management
window to open the Netfinity Event Scheduler service. Then Create
a new scheduled event using the Capacity Management task. For
more information, see “The Capacity Management Task Specific
Window” on page 143.

Viewing Reports

After reports have been created, you can use the Capacity
Management Report Viewer to examine the data that has been
collected. The Report Viewer presents the collected data in an
easy-to-understand and -manipulate interface. With this interface
you can view collected data from one or more systems
simultaneously.

To view a previously generated report:

1. Select View from the Capacity Management window.

Capacity Management
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This opens the Open window. Use this window to select the
report file that you want to view.

. Select Open to open the selected report file.

. Once the report is loaded into the Report Viewer, select one or

more systems whose data will be displayed in the Report
Viewer.

. Select a monitor from the Monitor pane.

You can select one monitor at a time. Once you select a
monitor, the data that was collected from the selected system (or
systems) is plotted as a line graph in the Report Viewer
window. If you select another monitor, the data will be plotted
again.



Cluster Manager

Cluster Manager is a powerful application designed to enhance the
cluster management capabilities of the Microsoft Cluster Server
(MSCS) administration console, included with Microsoft Windows
NT Server version 4.0 Enterprise Edition. Cluster Manager builds
on the power of MSCS, providing an integrated graphical interface
that enables you to quickly and easily monitor and manage the
clustered systems on your network. Clusters, the nodes that make
up a cluster, and their associated groups, resources, and network
information are presented in a tree view, making it simple to
quickly find the cluster element you want to work with. As cluster
elements are selected from the tree view, information about the
selected element appears in the Group, Resource, and Node or
Network information panels on the right side of the interface.

Note: The Node or Network Information panel displays information

about nodes when a group, resource, node, or cluster is
selected from the tree view. However, when network or
network resource items are selected from the tree view, this
panel displays network information.
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Figure 16. Cluster Manager
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Cluster Manager also provides powerful additional function that
greatly improves your ability to manage your clustered systems
effectively. With Cluster Manager, you can:

Manage all of your clusters from a single Microsoft NT
Workstation console running Netfinity Manager.

Manually allocate (or reallocate) dynamic resources and balance
the resources and load on your clustered servers.

Generate Netfinity alerts when cluster-related events (such as
failovers or other cluster-element changes) occur. Alerts can be
configured for individual clusters and cluster elements.

Search for all clusters on your network using the Cluster
Manager Discovery Function.

Use the Cluster Manager Cluster Expert Wizards to simplify the
creation of new file share, Internet Information Server, and print
spooler resource groups.

Simplify the management of the virtual IP addresses of the
clustered systems.

Use the Cluster Manager Scheduler to automatically perform
certain cluster-management tasks (such as taking cluster groups
offline, bring cluster groups online, or moving cluster groups
between nodes) at specified times of day or on specified dates.

Notes:

1. Cluster Manager runs only on systems running Microsoft

Windows NT Workstation version 4.0 with Service Pack 3 and
the Microsoft Cluster Server administrator console (MSCS)
installed. MSCS is included with Microsoft Windows NT Server
version 4.0 Enterprise Edition. For information on how to install
the MSCS Administrator Console, see the documentation that
came with Windows NT Server Enterprise Edition.

Cluster Manager requires the TCP/IP communications protocol
to communicate with clusters on your network.

Unlike other Netfinity services, Cluster Manager cannot be used
remotely by a Netfinity Manager using the Remote System
Manager service. Cluster Manager must be used locally, and



can only manage clusters that it can communicate with directly
using TCP/IP.

The Cluster Systems Manager Interface

To start Cluster Manager, double-click on the Cluster Manager icon
in the Netfinity Service Manager. After you start the Cluster
Systems Manager, you must open a connection to a cluster on your
network. To open a connection to a cluster:

1. Select Connect to from the File pull-down menu (or select the
Connect button from the button bar).

2. Type in the Cluster Name field the name of the cluster you
want to connect to and manage.

If you do not know the name of the cluster, use the Cluster
Manager Discovery function to find clusters on your network
(see “Discovering Clusters” on page 77).

3. Select OK to open a view of the cluster.

Note: After you have established a connection with a cluster, the
cluster’s name will appear as a selection in the View
pull-down menu. Once this selection is available, you can
open a connection with this cluster by selecting its name from
the View pull-down menu.

After you open a connection to a cluster, the Cluster Manager
interface displays detailed information about the cluster (see

Figure 16 on page 57). The Cluster Manager window is divided
into four panels. The panel on the left side of the Cluster Manager
window contains a tree view of all cluster elements. The tree view
includes the names of all clusters to which your system is currently
connected (for information on how to connect to a cluster, see
“Managing Clusters” on page 65).

If you select the plus sign beside any cluster, the tree view of that
cluster will expland to show folders and objects representing that
cluster’s groups, resources, resource types, networks, network
interfaces, and nodes. Plus signs will appear beside some of these
folders and objects; if you select these additional plus signs, the tree
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view will further expand, revealing other cluster elements such as
group names, network names, and cluster group owner names.

When you select a cluster element from the tree view, the three
panels on the right side of the window immediately are updated
and display information about the selected element. The three

panels are:

e Group Panel

The Group Panel contains the names of all groups that are
associated with the selected cluster element, as well as detailed
information about each cluster group including:

Group Item

State

Owner

Description

¢ Resource Panel

Meaning

The current state of the cluster group
(online or offline)

The node (within the cluster) that
currently owns this group

A user-defined description of the
group

The Resource Panel contains the names of all resources that are
associate with the selected cluster element, as well as detailed
information about each resource including:

Resource Item

State

Owner

Group

Resource Type

Description

Meaning

The current state of the cluster
resource (online or offline)

The node (within the cluster) that
currently owns this resource

The group that currently owns the
resource

The type of resource (for example,
Shared File Resource)

A user-defined description of the
resource



Node or Network Panel

If you select a cluster, node, group, resource, or network
resource from the tree view, the Node or Network Information
Panel contains information about the node or nodes that are
associated with the selected element including:

Node Item

Network

State

Adapter

Address

Description

Meaning

The name of the network that owns
the network node

The current state of the network
connection (up or down)

The name of the adapter that connects
this node to the network

The node’s virtual TCP/IP address

A user-defined description of the
node

If you select the networks element from the tree view, the Node
or Network Information Panel contains information about the
cluster’s network connection and resources, including:

Network ltem

State

Role
Mask

Description

Meaning

The current state of the network
connection (up or down)

The network’s role
The subnet mask for this network

A user-defined description of this
network

The information that is displayed in the information panels is
dependent upon the cluster element that you select from the cluster
tree view. For example, if you select a cluster from the tree view,
information on all groups and resources defined for use on the
cluster will be displayed in the information panels on the right side
of the window. However, if you select a node from the tree view,
only information about the groups and resources that are currently
owned by the selected node are displayed. Finally, if you select a
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group from the tree view, only the selected group and its resources
and the the node that currently owns the selected group will be
displayed.

Pull-Down Menus

Once you have opened a connection with a cluster, the Cluster
Manager window will feature five pull-down menus. These menus
are:

¢ File

Use the selections available from the File pull-down menu to
open or close a connection with a cluster, create new groups or
resources, and change the properties of currently defined groups
and resources.

Also, additional selections will appear in this pull-down menu
when you select cluster elements from any of the Cluster
Manager window panels. For example, if you select a resource
from the Resource Panel, additional selections appear that you
can use to change the group that owns this resource or to
initiate a failure of the selected resource.

All additional File pull-down menu selections are also available
if you open the selected cluster element’s context menu. To
open a element’s context menu, use the right mouse button to
select the element.

e View

Use the selections available from the View pull-down menu to
change the appearance of certain elements of the Cluster
Manager window, including the button bar and the size of the
icons that appear in the panels. You can also use the View
pull-down menu to see a list of all clusters to which your
workstation is currently connected, and to refresh the
information in the Cluster Manager window.

. Utility

Use the selections available from the Utility pull-down menu to
access Cluster Manager’s powerful cluster-management utility
programs. The following selections are available:



— Discover Cluster

Select Discover Cluster to use the Cluster Manager
Discovery function to search for and identify clusters that are
accessible from your workstation. For more information, see
“Discovering Clusters” on page 77.

— Alert Management

Select Alert Management to configure Cluster Manager alert
actions that will automatically be carried out when changes
to specified cluster elements occur. For more information,
see “Alert Service” on page 81.

— Scheduler

Select Scheduler to automatically take cluster groups offline,
bring cluster groups online, or move cluster groups between
nodes at specified times of day or on specified dates. For
more information, see “Scheduler” on page 79.

— Cluster Expert Wizard

Select Cluster Expert Wizard to simplify the creation of new
file-share resource groups, Internet Information Server
groups, or print spooler groups. For more information, see
“Cluster Expert Wizard” on page 91.

Tools

Use the selections available from the Tools pull-down menu to
reset the virtual IP address range that is used by the Cluster
Expert Wizard. For more information, see “Cluster Expert
Wizard” on page 91.

Window

Use the selections available from the Window pull-down menu
to rearrange the windows or icons currently displayed on your
desktop. You can choose cascade, tile and split window views,
and you can arrange the icons that are currently displayed.

Help

Use the selections available from the Help pull-down menu to
access online help for this service.
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The Button Bar

The Cluster Manager button bar features nine buttons that you can
use to quickly access many of the Cluster Manager most frequently
used functions. These functions are:

Open Connection
Opens the Open Connection window.
Alerts

Opens the Alert Service (for more information, see “Alert
Service” on page 81).

Discover

Opens the Clusters Discovery window (for more information,
see “Discovering Clusters” on page 77).

Refresh
Refreshes the contents of the Cluster Manager interface.
Switch to Large Icon View

Displays all cluster elements in the Cluster Manager information
panels as large icons.

Switch to Small Icon View

Displays all cluster elements in the Cluster Manager information
panels as small icons.

Switch to List View

Displays all cluster elements in the Cluster Manager information
panels as a list.

Switch to Details View

Displays all cluster elements in the Cluster Manager information
panels as a list with detailed information about each element.

About

Displays information about this version of Cluster Manager.



Managing Clusters

You can use Cluster Manager to manage a wide variety of
cluster-specific functions on all your cluster elements. After you
open a connection to a cluster, you are presented with a tree view of
the cluster and its elements (including nodes, groups, resources,
networks, and network resources). As you select individual
elements from the tree view, the information that appears in the
information panels on the right side of the window is updated
automatically, providing you with information specifically related to
the selected cluster element.

Before you can manage a cluster, you must first open a connection
to the cluster. You can open a connection to a cluster in two ways:

¢ Select Open Connection from the File pull-down menu (or
select the Open Connection button from the button bar).

This opens the Open Connection window. To open the
connection, type in the Cluster Name field the name of the
cluster you want to manage and then select Done.

¢ Use the Discovery function.

If you don't know the name of the cluster you want to manage,
or if you want to select from a list of clusters that are available
on your network, select Discover Cluster from the Utility
pull-down menu (or select the Discover button from the button
bar). This opens the Cluster Discovery window. For
information on how to use the Discovery function, see
“Discovering Clusters” on page 77.

When you've opened a connection to a cluster, all elements of the
cluster are displayed in the Cluster Systems Manager window tree
view. From this window you can easily:

¢ Move groups among nodes

¢ Move resources among groups

¢ Change cluster element properties
¢ Manage nodes

¢ Create, delete, and manage cluster groups
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¢ Create, delete, and manage cluster resources

¢ Manage the cluster network and network resources

Moving Groups

A group is a collection of related resources. Groups are owned by a
single node within the cluster, and can be configured to failover to
other nodes within the cluster in the event of a node failure.

With Cluster Manager, you can manually reallocate groups to
specific nodes. To move a group from one node to another node,
drag the group icon and drop it onto the icon of the node that you
want to own the group. Once the group icon is dropped, the group
and all its resources will automatically be transferred to the node.

You can also move groups by selecting the group, and then
selecting Move Group from the File pull-down menu.

Moving Resources

Resources are physical parts of the cluster (such as disk drives or IP
addresses) that are shared by the applications that run on your
cluster and that are associated with specific groups. You can use
Cluster Manager to manually move resources among groups on
your cluster.

To move a resource from one group to another group, drag the
resource icon from the former group and drop it onto the icon of
the new group that you want to own the resource. Once the
resource icon is dropped, the resource and all its dependencies are
automatically transferred to the group.

You can also move resources by selecting the resource, and then
selecting Move Resource from the File pull-down menu.

Changing Cluster Element Properties

All cluster elements feature user-definable properties. To examine
or change the properties of a cluster element, select the cluster
element and then select Properties from the File pull-down menu.
The cluster element Properties window opens.



Once the Properties window is open, you can make changes to the
cluster element’s properties. When you have finished making
changes to these properties, select OK to save these changes and
close the Properties window. To close the window without saving
changes, select Cancel.

The contents of the Properties window depend on the cluster
element that is selected, and some Properties windows include more
than one page of properties. Also, some windows contain data
fields that cannot be altered.

Cluster Properties
The Cluster Properties window contains the following items:

Name The name of the cluster

Description A description of the cluster (optional)

Quorum Resource The quorum disk resources used by the
cluster

Node Properties
The Node Properties window contains the following items:

Name The name of the node
Description A description of the node (optional)
State The current state of the node

Group Properties
The Group Properties window contains the following items:

¢ General Page

Name The name of the group
Description A description of the group (optional)
Preferred Owners The name of the node that is the

preferred owner of the group
State The current state of the group

Node The name of the node that currently
owns the group
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Resource Properties

Failover Page
Threshold

Period

Failback Page

The number of times failover is
permitted during a specified time
period (the value in the Period field)
before the group is taken offline

The time period used to determine
whether a group must be taken
offline after a specific number of
failovers (the value in the Threshold
field)

Prevent Failback radio button

Prevents this group from failing back
to its preferred owner once a failover
has occurred.

Allow Failback radio button

Permits this group to fail back to its
preferred owner once a failover has
occurred. Use the Immediately and
Failback Between radio buttons to
specify the manner in which failback
will occur.

The Resource Properties window contains the following items:

General Page
Name

Description

Possible owners

The name of the resource

A description of the resource
(optional)

The groups that have access to the
resource. Select Modify to add or
remove owners from the possible
owners list.



Run this resource in a separate resource monitor check box

Group

State
Node

Dependencies Page

Select this check box to run this
resource in a separate resource
monitor.

Note: Use this option only if you
anticipate a conflict with
another resource or for
debugging purposes.

The name of the group that currently
owns the resource

The current state of the resource

The node that currently owns the
resource

Lists all other cluster resources that must be brought online
before this resource can be brought online. Select Modify to
add dependencies to or remove dependencies from this list.

Advanced Page

Do Not Restart radio button

Restart radio button

Prevents this resource from restarting
if it fails.

Permits this resource to restart after a
failure. Select the Affect the group
check box to enable the group that
currently owns the resource to return
to online after the resource restarts.

“Look Alive” Poll Interval

“Is Alive” Poll Interval

Pending Timeout

The amount of time between “Look
Alive” polls

The amount of time between “Is
Alive” polls

The amount of time allowed for
resources to be in a pending state
before they fail
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e Parameters Page

Contains a list of all cluster nodes that own or share this
resource

Network Properties
The Network Properties window contains the following items:

Name The name of the network
Description A description of the network (optional)

Enable for cluster use check box
Enables the cluster to use this network.
Use the Use for all communications, Use
only for internal communications, and
Use only for client access buttons to
specify the manner in which the cluster
will use this network.

State The current state of the network

Subnet mask The subnet mask used by the network

Managing Nodes

A node is a single system that is part of a cluster and that owns
groups and their resources. The cluster server runs on each node
and enables each node to communicate and work with the other
nodes in the cluster. You can use Cluster Manager to:

e Start a node

Starts the cluster server on a node. To start a node, select the
node from the tree view and then select Start from the File
pull-down menu.

e Stop a node

Stops the cluster server on a node. To stop a node, select the
node from the tree view and then select Stop from the File
pull-down menu.

e Evict a node



Removes the node from the cluster. To evict a node, select the
node from the tree view, select Stop from the File pull-down
menu, and then select Evict from the File pull-down menu.

Pause a node

Temporarily stops the node from functioning as part of the
cluster. To pause a node, select the node from the tree view
and then select Pause from the File pull-down menu.

Resume a node

Restarts a paused node. To resume a node, select the node from
the tree view and then select Resume from the File pull-down
menu.

Change node properties

For information on changing node properties, see “Changing
Cluster Element Properties” on page 66.

Creating, Deleting, and Managing Groups
A group is a collection of shared resources that are used by
applications running on the cluster. You can use Cluster Manager

Create groups
To create a new group:.
1. Select New and then Group from the File pull-down menu.

This opens the New Group window (see Figure 17 on
page 72).
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Figure 17. The New Group window

2. Type in the Name field the name of the new group.

3. Type in the Description field a description of the group
(optional)

4. Select Next.

This opens the Preferred Owners window (see Figure 18 on
page 73).



(Profmat Bty |
iﬂﬂl—ﬁrﬁ

Spmoiy e noder e chum wyihe ardey w shach Py b be cormmim el
by e marang vt ke e i b R e

ol ke i P Chaden Fusboun] Comrmes
= DL |
Rl O]

ifmt [ b ] caes | e |

Figure 18. The Preferred Owners window

5. Select preferred owners for this group.

6. Select Finish.

You can also use the Cluster Expert Wizard to create resource
groups. For more information, see “Cluster Expert Wizard” on

page 91.

¢ Delete groups

To delete a group, select the group from the tree view and then

select Delete from the File pull-down menu.

e Bring groups online

To bring a group online, select the group from the tree view and

then select Bring Online from the File pull-down menu.

e Take groups offline

To take a group offline, select the group from the tree view and

then select Take Offline from the File pull-down menu.

¢ Change group properties

Changing group properties enables you to rename the group,
change the preferred owners of the group, and set failover and
failback policies for the group. For information on changing
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group properties, see “Changing Cluster Element Properties” on
page 66.

¢ Moving groups to other nodes

For information on moving groups, see “Moving Groups” on
page 66.

Creating, Deleting, and Managing Resources
Resources are physical parts of the cluster (such as disk drives or IP
addresses) that are shared by the applications that run on your
cluster and that are associated with specific groups. You can use
Cluster Manager to:

¢ Create resources
To create a resource in a cluster:

1. Select New and then Resource from the File pull-down
menu.

This opens the New Resource window (see Figure 19).

New Resource
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Figure 19. The New Resource window

2. Type in the Name field the name of the resource.
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3. Type in the Description field a description of the resource
(optional).

4. Select from the Resource type selection list the type of
resource you want to create.

5. Select from the Group selection list the name of the group
that the resource will be created in.

6. Select the Run the resource in a separate Resource Monitor
check box if needed.

Note: Use this option only if you anticipate a conflict with
another resource or for debugging purposes.

7. Select Next. This opens the Properties window for this
resource (see Figure 20).
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Resouwrce type:  Physical Digk

Group: Dizk Group 1
State; Online
MNode NODEC

ok I Cancel ol Help

Figure 20. The Resource Properties window
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8. Specify possible owners for this resource. To add or remove
possible owners from the list of owners displayed in the
Possible owners field, select Modify.

9. Select OK. This opens the Dependencies window (see
Figure 21).

@ New Resource
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Figure 21. The Dependencies window

10. Select dependencies (if any) for this resource from the
Available Resources selection list and then select Add to
add them.

11. Select Next and then Finish to create the new resource.
¢ Delete resources

To delete a resource, select the resource from the tree view and
then select Delete from the File pull-down menu.

e Bring resources online

To bring a resource online, select the resource from the tree
view and then select Bring Online from the File pull-down
menu.

¢ Take resources offline
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To take a resource offline, select the resource from the tree view
and then select Bring Online from the File pull-down menu.

¢ Initiate resource failures

You can initiate resource failures to test failover and failback
functions. To initiate a resource failure, select the resource from
the tree view and then select Initiate Failure from the File
pull-down menu.

e Change resource properties

Changing resource properties enables you to rename, add or
remove possible owners, add or remove dependencies, set
restart policies, specify polling intervals, and set pending
timeout values for the resource. For information on changing
resource properties, see “Changing Cluster Element Properties”
on page 66.

» Move resources to other groups

For information on moving resources, see “Moving Resources”
on page 66.

Managing the Cluster Network and Network Resources

The cluster network and network resources are very similar to other
cluster resources. All management of the cluster network resources
is performed using the Network Properties window. Using this
window, you can rename the network, enable or disable the
network for use by the cluster, and specify the manner in which the
network will be used by the cluster. For more information on
changing network properties, see “Changing Cluster Element
Properties” on page 66.

Discovering Clusters

You can use the Cluster Manager Discovery function to easily search
your TCP/IP network for all clusters that are accessible from your
workstation. Once remote clusters are discovered, you can open a
connection to any discovered cluster and begin managing it
immediately. Discovery can search for clusters on all domains in
your network, or you can specify that only specified domains be
searched.
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To use the Cluster Manager Discovery function:

1. Select Discover Clusters from the Utility pull-down menu, or
select the Discover Clusters button from the Cluster Manager
window button bar. The Discover Clusters window opens (see
Figure 20 on page 75).

Dizcover clusters |
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Figure 22. The Discover Clusters window

2. Specify TCP/IP domains to be searched for clusters (optional).

By default, the Discovery function will search for clusters on all
TCP/IP domains on your network. To limit Discovery searches
to a specific TCP/IP domain, select a domain from the Domain
selection list.

3. Select Browse to initiate the cluster search.

A list of all clusters that are found on your TCP/IP network (or, if
you limited the search to a specific domain, a list of all clusters
found in the specified TCP/IP domain) appears in the Discovered
Cluster Process window (see Figure 23 on page 79). From this
window you can open a view of the cluster in the Cluster Systems
Manager window or define alerts for the discovered clusters (for



more information on alerts see “Alert Service” on page 81). To
open a view of a discovered cluster in the Cluster Systems Manager
window, double-click on the discovered cluster.
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Figure 23. The Discovered Clusters Process window

Note: You can also define alerts from the Cluster Discovery
window. The process for defining alerts from this window is
identical to the process for defining alerts using the Cluster
Manager Alert Service. However, only cluster events that
affect all of a type of cluster element (for example, all groups
in a cluster or all nodes in a cluster) can be defined from the
Cluster Discovery Service. For more information, see “Alert
Service” on page 81.

Scheduler

You can use the Cluster Manager Scheduler to perform
cluster-specific tasks automatically at a user-specified time. With
the Cluster Manager Scheduler, you can automatically:

¢ Bring groups online

e Take groups offline
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¢ Move groups to other nodes

When the Scheduler performs these tasks, results are reported using
the Cluster Manager Alert Service. The Cluster Manager Scheduler
runs independent of Cluster Manager, so Cluster Manager does not
need to be running for scheduled tasks to be performed.

Note: Scheduled tasks will be performed once and once only. To
perform scheduled cluster-management tasks repeatedly over
a specified time interval (once a week, for example) you must
assign multiple scheduled tasks.

To start the Cluster Manager Scheduler, select Scheduler from the
Utility pull-down menu. This opens the Scheduler window (see
Figure 24).
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Figure 24. The Cluster Manager Scheduler window

The Scheduler window is divided into three panels. The view on
the top left side of the window shows the schedule time tree
(hierarchically organized by year, month, day, hour, and five-minute
intervals). The view on the top right side of the window shows a
list of tasks that can be scheduled. Finally, the view on the bottom
shows the currently scheduled tasks.



To update the information that is presented in the Scheduler
window, select Update from the View pull-down menu or select the
Update button on the button bar.

Scheduling a Cluster Task

To schedule a Cluster Manager task:
1. Start the Cluster Manager Scheduler.
2. Select a task from the top right panel of the Scheduler window.

3. Drag the selected task to the schedule time tree view and drop
it on the time period at which the task will be performed.

After you finish scheduling the task, it will appear in the currently
defined tasks panel at the bottom of the Scheduler window. The
task will be performed automatically when scheduled time period
arrives.

Deleting a Scheduled Cluster Task

To delete a previously scheduled task, use the right mouse button to
select the scheduled task from the Scheduler window (this opens the
task context menu) and then select Delete from the context menu or
select the scheduled task from the Scheduler window and then
select Delete from the File pull-down menu.

Alert Service

Cluster Manager can be configured to monitor the clusters on your
network for cluster-related changes (such as cluster elements being
added, being deleted, or changing state). If any of these events
occurs, Cluster Manager can be configured to automatically generate
a Netfinity alert and perform one of a variety of alert actions in
response to the alert.

Alerts can be configured in one of two ways:

e Using the Alert Service

The Alert Service is used to configure alerts after you have
opened a connection with a cluster (either by connection to the
cluster using the Connect to button or by double-clicking on a
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cluster that you have discovered using the Discovery function).
When you use the Alert Service window, you can assign events
and alerts for any cluster element, including individual groups
and resources.

Using the Cluster Discovery window

After clusters are discovered, they are displayed in a tree view
in the Cluster Discovery window (see Figure 23 on page 79), a
window that closely resembles the Alert Service window. Alerts
can be configured using this window. However, only events
that affect all cluster elements on a cluster (all resources, nodes,
or groups for example) can be assigned to generate alerts when
you define alerts using the Cluster Discovery window. Though
you cannot assign events and alerts to individual cluster
elements, you can use the Cluster Discovery window to easily
assign alerts to multiple clusters on your network
simultaneously.
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Figure 25. The Alert Service window

Whether you us the Alert Service of the Cluster Discovery function,
you use the same process to select a cluster element event, assign it




to a cluster or cluster element, and configure the alert and response
that will be generated in response to the event.

1. Open a connection to a cluster.
To open a connection to a cluster:

a. Select Connect to from the File pull-down menu (or select
the Connect button from the button bar).

b. Type in the Cluster Name field the name of the cluster you
want to connect to and manage.

c. Select OK to open a view of the cluster.

If you do not know the name of the cluster, use the Cluster
Manager Discovery function to find clusters on your network
and then double-click on a discovered cluster. For more
information on the Discovery function, see “Discovering
Clusters” on page 77.

2. Select Alerts from the Utilities pull-down menu (or select the
Alerts button from the button bar).

For information on how to open the Discovery Clusters window, see
“Discovering Clusters” on page 77.

Defining Cluster Alerts

To define a cluster event alert and alert action response:

1. Start the Alert Service (or open the Discover Clusters window.
For information on how to open the Discovery Clusters
window, see “Discovering Clusters” on page 77).

2. Select the event you want to monitor for from the Alert Service
events panel (the upper right-hand panel of the window).

For information about cluster events that can be monitored
using the Cluster Manager Alert Service , see “Available Cluster
Events” on page 87.

3. Drag the event from the events panel to the cluster tree view
panel (the upper left-hand panel of the window) and drop it on
the cluster element you want the event to apply to.
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For example, if you want to monitor the cluster for any cluster
events, drag All Cluster Events from the events panel and drop
it on the cluster icon in the cluster tree view. This opens the
Alert Configuration window for the selected cluster element (see
Figure 26). The window will have the name of the selected
cluster element in the title bar.
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Figure 26. The Alert Configuration window

4. Type in the Alert Name field a name for the alert.

5. Select from the Cluster object selection list a cluster element to
monitor (optional).

The name of the cluster element you selected will be displayed
in this window.

6. Select from the Event type selection list the cluster event you
want to monitor (optional).
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The name of the cluster event you selected from the cluster
events tree will be displayed in this window.

7. Select Netfinity from the System Management Platform button
group.

This determines the format of the alert that will be generated
and the actions that are available to be taken in response to the
alert. If you also have Intel LANDesk or Microsoft SMS
installed on your system, buttons will be available for these
products as well. This publication covers Netfinity functions
only. For information about other systems-management
platform alerts and actions that are available, see the Cluster
Manager online help or refer to the IBM Cluster Systems
Management User’s Guide.

8. Select from the System Management Platform Alert Action
selection list the alert action that will be taken in response to the
alert and provide any additional parameters needed.

When you select an alert action, additional parameter fields
might appear beneath the System Management Platform Alert
Action selection list. Provide the additional needed information
to configure alert actions that require additional parameters.

For information about Netfinity alert actions that can be used
with Cluster Manager Alert Service, see “Available Cluster Alert
Actions” on page 89.

9. Specify an Alert Severity

The Severity is a number from 0 through 7 that indicates how
serious a generated alert is. A severity of 0 represents a very
serious alert, while a severity of 7 is relatively minor.

10. Select OK to save this cluster alert action.

When a cluster alert is defined and saved, it appears in the Alert
Service alerts information panel (the bottom half of the Alert Service
window).

Select Cancel at any time to close this window without saving any
cluster alert information.
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Deleting Cluster Alerts

To delete a previously defined cluster alert action:
1. Start the Alert Service (or open the Cluster Discovery window).

2. Double-click on any event in the Alert Service events panel (the
upper right-hand panel of the window).

This opens the Alert Configuration window for the selected
element.

3. Select the Manage Alerts tab in the Alert Configuration
window. This changes the view of the Alert Configuration
window to a view of all events and alerts that are currently
defined for the cluster (see Figure 27).

All Clusters
Configure Alert  Manage Alerts |
— Registered Alert List
Alert Mame | Cluster Object | Event Type | Alert Action
1| | o
Delete &l | Delete |

QK I Cancel | Anpli | Help |

Figure 27. The Manage Alerts view

4. Select one (or more) cluster alerts that you want to delete.



5. Select Delete.

To delete all previously defined cluster alerts, select, Delete All.

Available Cluster Events

You can use Cluster Manager to monitor any of the following
cluster events. If one of these events occurs and you have
configured a cluster alert using the Alert Service, a Netfinity alert
automatically will be generated and an alert action taken in
response to the alert.

All Cluster Events
The alert will be generated if any Cluster event occurs.
All Node Events

The alert will be generated if any node event (Node State, Node
Added, Node Deleted) occurs.

Node State (Up, Down, Paused)

The alert will be generated if the node changes state.

Node Added

The alert will be generated if a node is added to the cluster.
Node Deleted

The alert will be generated if the node is deleted from the
cluster.

All Group Events

The alert will be generated if any group event (Group State,
Group Added, Group Deleted) occurs.

Group State (Online, Offline, Failed)

The alert will be generated if the group changes state.
Group Added

The alert will be generated if a group is added to the node.

Group Deleted
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The alert will be generated if the group is deleted from the
node.

All Resource Events

The alert will be generated if any resource event (Resource State,
Resource Added, Resource Deleted) occurs.

Resource State (Online, Offline, Failed)

The alert will be generated if the resource changes state.
Resource Added

The alert will be generated if a resource is added to the group.
Resource Deleted

The alert will be generated if the resource is deleted from the
group.
All Network Events

The alert will be generated if any network event (Network State,
Network Added, Network Deleted) occurs.

Network State (Up, Partitioned, Down)

The alert will be generated if the network changes state.
Network Added

The alert will be generated if a network is added to the cluster.
Network Deleted

The alert will be generated if a network is deleted from the
cluster.

All Net Interface Events

The alert will be generated if any network interface event
(Network Interface State, Network Interface Added, Network
Interface Deleted) occurs.

Network Interface State (Up, Unreachable, Failed)

The alert will be generated if the network interface changes
state.

Network Interface Added



The alert will be generated if a network interface is added to the
cluster.

Network Interface Deleted

The alert will be generated if the network interface is deleted
from the cluster.

Available Cluster Alert Actions

The following Netfinity alert actions are available for use with the
Cluster Manager Alert Service:

Log
Select Log to send the alert to the Netfinity alert log.
NT Event Log

Select NT Event Log to use Netfinity to enter the alert into the
NT Event Log.

Digital Pager

Select Digital Pager to use Netfinity to use a modem attached to
your system to dial out and deliver the information using a
digital pager service.

Additional Parameters
- <P1> Modem COM Port

The COM port that the modem is configured to use. The
COM port parameter must be typed in the parameter field
as COM x, where x is the number of the COM port.

— <P2> Pager number

The telephone number that must be dialed by the modem to
forward the information to the digital pager.

— <P3> Digital pager display
The numeric data that will be displayed on the pager.

Note: Depending on your paging service, you might need to
increase the amount of time that this alert action waits
after dialing the telephone number in parameter field
<P2> before it transmits the numeric data in parameter
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field <P3>. To increase the amount of time that will pass
before the numeric data is transmitted, add one or more
commas (,) to the end of the telephone number in field
<P2>. Each comma will cause the modem to wait two
seconds before transmitting the numeric data.

¢ Alphanumeric Pager

Select Alphanumeric Pager to use a modem attached to your
system to send all alert information and additional text (if
needed) to an alphanumeric pager using telocator alphanumeric
protocol (TAP).

Additional Parameters

<P1> Modem COM Port

The COM port that the modem is configured to use. The
COM port parameter must be typed in the parameter field
as COM x, where x is the number of the COM port.

— <P2> TAP Access Number

The telephone number that must be dialed by the modem to
forward the information to the alphanumeric pager.

— <P3> Pager ID

The identification number of the pager to which the data
will be sent.

- <P4> Additional text to send

Any additional text that you want to send along with the
alert data. This parameter is optional.

Notes:

1. This action will work only with pager services that use the
telocator alphanumeric protocol (TAP).

2. You must provide your pager's Pager ID.
Execute a Command

Select Execute a Command to execute a command when the
alert is received.

Additional Parameters



- <P1> Command
The command that will be executed on the system.
e Message Popup

Select Message Popup to display the alert in a popup window.

Cluster Expert Wizard

You can use the Cluster Manager Cluster Expert Wizard to quickly
and easily create several commonly used resource groups, including:

¢ File-share resource group
¢ Internet Information Server (l1S) resource group

» Print spooler resource group

With Cluster Expert Wizard you can create groups by defining new
resource groups into already existing resource groups. This is
especially useful when you have a limited number of physical disks
that need to serve multiple purposes for your environment. For
example, a single physical disk can be used to store data for
multiple file share groups and multiple IIS groups.

During startup of the system, Cluster Manager prompts you for a
range of virtual IP addresses. A sequential range of IP addresses is
created for use in the system.

Note: When you add the range of numbers, do not include any
numbers that are currently active. For example, if the address
of 9.9.9.10 is assigned, do not use the range of
9.9.9.1-9.9.9.100, start with 9.9.9.11-9.9.9.109.

If an IP address is deleted, Cluster Expert Wizard automatically
adds that number to the list of IP addresses that are available for
use by the cluster.

To start the Cluster Expert Wizard, select Cluster Expert Wizard

and then the type of resource group you want to create from the
Utilities pull-down menu.
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Creating or Changing File Share Resource Groups
A File Share Resource Groups shares the directory of the server, on
one of the shared disks in your configuration. The configuration of

a file-share group is identical to the configuration of a file-share
group in Windows NT Explorer. For example, you can store files in
a shared directory on the server and give access only to a group of
clients.

You can create a file share resource group or change an existing file
share resource group.

Note: Before creating a file share resource, ensure that a disk drive
is available. If a hard disk drive is not available, the default
is to change a file share resource.

To create a new file-share resource group:

1. Select Cluster Expert Wizard and then File Share from the
Utilities pull-down menu.

The Expert Wizard window appears with information pertaining
to file-share resources available for use (see Figure 28).
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Figure 28. The Cluster Expert Wizard File Share Resource window

2. Select Create a new group
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Specify the Share Name, Path, and Network Name for the file
share resource group.

Specify the Network Interface for the file-share resource group.
Choose the Disk Drive for the file share resource group.

Select Finish.

To change a file share resource group:

1.

Creating Internet Information Server Resource Groups

Select Cluster Expert Wizard and then File Share from the
Utilities pull-down menu.

The Expert Wizard window appears with information pertaining
to file share resources available for use (see Figure 28 on
page 92).

Select Change an existing group

Select from the File Share Resource selection list the name of
the file-share resource you want to change.

Change file-share properties as desired.

Select Finish.

An Internet Information Server (11S) resource group provides high
availability to the World Wide Web, FTP, and Gopher components
of the Microsoft Internet Information Server. If a node fails, another
node will supply the client with the data.

To create an Internet Information Server resource group:

1.

Select Cluster Expert Wizard and then 1S from the Utilities
pull-down menu.

The Expert Wizard window appears with information pertaining
to IIS resources available for use (see Figure 29 on page 94).
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Figure 29. The Cluster Expert Wizard IIS resource group window

2. Select Create a new group.

3. Specify the Directory, Alias, and Network Name for the 1IS
resource group.

4. Specify the Network Interface for the IIS resource group.
5. Choose the Disk Drive for the IS resource group.

6. Select Finish.

Creating or Changing Print Spooler Resource Groups
When a server functions as a print spooler, the server must specify

where the print spooler stores its data. A print spooler resource

group provides a spool directory on the shared storage disk where

print jobs will be spooled.

You can create a print spooler resource group or change an existing
print spooler resource group.
To create a print spooler resource group:

1. Select Cluster Expert Wizard and then Print Spooler from the
Utilities pull-down menu.



The Expert Wizard window appears with information pertaining
to print spooler resources available for use (see Figure 30 on
page 95).
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Figure 30. The Cluster Expert Wizard print spooler resource group window

Select Create a new group.

Specify the Spool Folder, Job Completion, and Network Name
for the print spooler.

Specify the Network Interface for the print spooler.
Choose the Disk Drive for the print spooler.

Select Finish.

To change a print spooler resource group:

1.

Select Cluster Expert Wizard and then Print Spooler from the
Utilities pull-down menu.

The Expert Wizard window appears with information pertaining
to rprint spooler resources available for use.

Select Change an existing group

Select from the Print Spooler Resouce selection list the name of
the print spooler resource you want to change.
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4. Change print spooler properties as desired.

5. Select Finish.
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Critical File Monitor

Critical File Monitor can warn you whenever critical system files on
the systems in your network are deleted or altered. The Critical File
Monitor service makes it simple for you to generate Netfinity alerts
when an important system file (such as the CONFIG.SYS file)
changes date, time, size, is deleted (when it was present previously),
or is created (when it was not present previously). Critical File
Monitor can also be used to monitor any other files that reside on a
Netfinity system.

= 7| d
-~05/2 System Files
Filename Severity
CONFIG.SYS
: |f§ Zi
[_1 Hotify
STARTUP.CHMD
: |E§ Z]
[_] Motify
AUTOEXEC.BAT
: |f§ Zi
[_1 Hotify

Additional Monitored Files:

[monitor another file]

Save Datatg Cancel | | Help |

Figure 31. Critical File Monitor

Monitoring System Files

The system files that can be monitored by the Critical File Monitor
are operating-system-specific. The name of the operating system
that is in use by the system that you are accessing appears in the
title area of the System Files field group. The names of the system
files that can be monitored appear beside the check boxes.
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Notes:

1. You can use Critical File Monitor to monitor any file on the
system. The system files that appear at the top of the Critical
File Monitor window are important files that you would be
most likely to want to monitor. To monitor other files, see
“Monitoring Other Files” on page 99.

2. Files located on network drives cannot be monitored.

0OS/2 System Files

The OS/2 system files that appear in the System File field group
are:

* CONFIG.SYS
e STARTUP.CMD
e AUTOEXEC.BAT

Windows 3.1, Windows for Workgroups, and Windows

95 System Files

The Windows system files that appear in the System File field group
are:

e CONFIG.SYS

e AUTOEXEC.BAT
e WIN.INI

e SYSTEM.INI

Windows NT System Files
The Windows NT system files that appear in the System File field
group are:

e WIN.INI
e SYSTEM.INI
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NetWare System Files
The NetWare system files that appear in the System File field group

are:

AUTOEXEC.NCF
STARTUP.NCF
VOLS$LOG.ERR
SYS$LOG.ERR

To monitor one or more system files:

1.

4.

Select the system files that you want to monitor.

Select the Notify check boxes below the names of the system
files that you want to monitor. A check mark appears in the
box.

Select a Severity.

Each system file in the System File field group has a Severity
field beside its name. Use the spin buttons to select a Severity
value for each of the system files that you want to monitor.
This severity value will be assigned to the Netfinity alert that
will be generated if the system file is created, deleted, or
changed. You can choose a severity value from 0 (most severe)
to 7 (least severe).

Select Local Notify (optional).

Select the Local Notify if you want to direct the alert to the
Alert Manager on the system which you are monitoring.

Select Save to save the Critical File Monitor settings.

To close Critical File Monitor without saving any changes, select
Cancel.

Monitoring Other Files

Critical File Monitor can monitor any file on the Netfinity system
that you are accessing. The Additional Monitored Files field
contains a list of all other files that are currently being monitored.
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To select a file to monitor:

1. Select (monitor another file) from the Additional Monitored
Files field (see Figure 31 on page 97).

This will open the Monitor window (see Figure 32).

8 +onior |
Monitor filename:
f
L Hetifg
Alert Severity: Drive:
[ 7 |c: |-l
File: Directory:
ads. txt +| [BACKEXP =
ASGADDR.THKT | [CID B
AUTOEXEC.BAT Desktop
boot.dat | |DMISL -
e 1 | = =
Bhoritny | Cancel | | Help |

Figure 32. Critical File Monitor — Monitor window
2. Select from the Drive list the drive letter that contains the file
that you want to monitor.

3. Select from the Directory field the directory that contains the file
that you want to monitor.

4. Select from the File list the name of the file that you want to
monitor.

5. Use the spin buttons beside the Severity field to set the Severity
of the alert that will be generated if the selected file is altered or
deleted.

6. Select Local Notify (optional).

Select the Local Notify if you want to direct the alert to the
Alert Manager on the system which you are monitoring.

7. Select Monitor to initiate the monitoring process on the selected
file.
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To close the Critical File Monitor service without saving any
changes, select Cancel.

Note: Critical File Monitor can be set to alert you if a specific file
that does not exist on the system is created. For more
information, see “Monitoring for File Creation.”

Monitoring for File Creation

Critical File Monitor can also generate alerts when specified files are
created. To configure the Critical File Monitor to generate an alert
in this case:

1. Select from the Drive field the letter of the disk drive that you
want to monitor for file creation.

2. Type in the Monitor Filename field the fully qualified path and
name of the file that you want to monitor.

For example, if you want the Critical File Monitor to generate an
alert if a file named ERROR.LOG appears in the directory
named PROGRAM, you would type in the Monitor Filename
field

PROGRAM\ERROR. LOG

3. Use the spin buttons beside the Severity field to set the Severity
of the alert that will be generated if the file is created.

4. Select Local Notify (optional).

Select the Local Notify if you want to direct the alert to the
Alert Manager on the system which you are monitoring.

5. Select Monitor to initiate the monitoring process on the
specified file.
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DMI Browser

You can use the Netfinity Desktop Management Interface (DMI)
Browser Service to examine information about the DMI-compliant
hardware and software products (called DMI components) installed
in or attached to the system.

You can use the DMI Browser to:
¢ View information about DMI components

¢ Receive notification of problems or errors with products from
the DMI Service Layer

¢ View the log of problems or errors concerning DMI components

Notes:

1. This service is available only on systems that have the DMI
Service Layer installed and operational. DMI Service Layers are
available for most of the operating systems that are supported
by Netfinity. If a DMI Service Layer is not installed and
operational on your system when you install Netfinity, neither
the DMI Browser nor the Netfinity-specific DMI components
will be installed on your system. If you install a DMI Service
Layer after you install Netfinity, you must reinstall Netfinity in
order to install and use Netfinity's DMI Component
Instrumentation.

2. The Netfinity DMI Browser service is a special version of the
DMI Browser that comes with the DMI Service Layer. Some
functions that are available with the DMI Browser are not
available in Netfinity’s DMI Browser service.

What is DMI?

The Desktop Management Interface (DMI) is an industry standard
that simplifies management of hardware and software products
attached to, or installed in, a computer system. The computer
system can be a standalone desktop system, a node on a network, or
a network server. DMI is designed to work across desktop
operating systems, environments, hardware platforms, and
architectures.
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DMI provides a way to provide or obtain, in a standardized format,
information about hardware and software products. Once this data
is obtained, desktop and network software applications can use that
data to manage those computer products. As DMI technology
evolves, installation and management of products in desktop
computers will become easier, and desktop computers will become
easier to manage in a network.

How Does DMI Work?

The complete DMI structure consists of three separate elements:

e DMI components
e DMI Service Layer
¢ DMI-compliant management applications

DMI Components

Each DMI component contains information about the product with
which it is associated. This information is organized into
product-specific groups. This information is contained in a
Management Information File (MIF). The MIF describes the
manageable attributes of the DMI component or product.

Each group contains a variety of group-specific attributes. The
attributes that are found within a group are entirely dependent on
the group itself. For example, the Component ID group for a
software product might include the following attributes:

¢ Manufacturer
¢ Product

¢ Version

¢ Serial Number
¢ [nstallation

e Verify

However, the attributes found in the Processor group included in a
PC system’s component might contain these attributes:

e Type
e Processor Family
¢ Version Information

DMI Browser
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¢ Maximum Speed
e Current Speed
e Processor Upgrade

Each of a group's attributes is fully defined by a series of data items.
The items available for a group vary according to the type of
product, but most attributes include the following data items:

ID The attribute's ID is a sequential number
unique to the attribute's group.
Type The data type can be one of eight defined by
DMI. These data types are:
e Integer
e 64-Bit Integer
e Counter
e 64-Bit Counter
e Gauge
¢ Display String
e Octet String
e Date
Access The ways in which this attribute's data can be
accessed. Access values can be:
¢ Read-Only
e Read-Write
¢ Write-Only

Note: Attributes that have Read-Write or
Write-Only access values can have
certain other attributes changed. For
more information, see “Changing
Attribute Information” on page 109.

Name The name of the attribute is derived from DMI
standards or is provided by the manufacturer.
Value A value is a specific occurrence of an attribute.

For example, an attribute value of 2.1 could be
provided for the version number of an
application. In a few cases, a value is
read-only and will never change. The value
can be specified directly in the MIF file.
However, most values will change over time.
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Updating usually occurs automatically,
managed by programs supplied by the
manufacturer of the component.

A value can also be an enumeration value
(ENUM), indexing into a table of possible
values defined in the MIF file.

Description The description of the component is technical
information supplied by the manufacturer.

Netfinity DMI Component Instrumentation

The Netfinity DMI Component Instrumentation provides DMI-based
management applications with information from Netfinity's Remote
System Manager, System Monitors, and System Information Tool.
The MIF files required by DMI-based management applications are
installed as part of Netfinity's DMI Instrumentation when Netfinity
is installed.

Notes:

1. If a DMI Service Layer is not installed and operational on your
system when you install Netfinity, neither the DMI Browser nor
the Netfinity-specific DMI components will be installed on your
system.

2. DMI-based Netfinity data is available to other DMI-based
application only when the Netfinity Support Program is
running.

DMI Service Layer

The DMI Service Layer is a program that gathers and organizes the
DMI component information into a standardized format. Once this
data has been organized and is available, a DMI-compliant
component agent (Netfinity’s DMI Browser service, for example) can
access the DMI service layer and request information about any of
the DMI components.

Note: Your system must have the DMI Service Layer installed and
operational for Netfinity’s DMI Browser to function.
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The DMI Service Layer gathers configuration information from the
installed MIF files, builds a database, and, upon request, passes the
information to management applications. Management applications
are programs that are capable of receiving data from the DMI
Service Layer and providing this data for desktop or network
management purposes.

In addition to gathering and configuring the MIF data, the DMI
Service Layer also collects information about problems or errors that
the various DMI components have encountered. You can use the
Netfinity DMI Browser to receive notification of problems or errors
concerning your DMI components and to view a log of problems or
errors concerning your DMI components.

The Netfinity DMI Browser works with the following DMI Service
Layers:

Operating System Supported DMI Service Layer

OS/2 Warp 3.0 or later  IBM SystemView Agent version 1.4.2 or
later

Windows NT 3.51 with Service Pak 5 or later
IBM SystemView Agent version 1.3.2 for
WIN32, Intel DMI Service Provider 2.0

Windows 95 IBM SystemView Agent version 1.3.2 for
WIN32, Intel DMI Service Provider 2.0
Windows 3.1 Intel® DMI SDK version 2.0 or later

Management Applications

A management application is any DMI-compliant
systems-management application that is capable of interfacing with
the DMI Service Layer in order to gather and make use of the DMI
component information.



Using the DMI Browser

The Netfinity DMI Browser service enables you to:

¢ View information about DMI components, groups, and
attributes of installed DMI-compliant products

¢ Receive notification of problems or errors with your products
from the DMI Service Layer

¢ View the log of problems or errors concerning your DMI
components

The DMI Browser functions can be accessed by selecting menu
choices from the menu bar, or by selecting the function’s
corresponding objects from the fast-path icon bar.
The menu bar includes the following functions:

e Options: View the event log or exit the DMI Browser service.

¢ Information: Display version information for the Service Layer
and copyright notices for the DMI Browser.
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Figure 33. The DMI Browser window

For quickest operation, use the mouse to select the menu bar icon
that you want. The alternative is to select a menu choice and then
select a choice from the menu that drops down. If you are unsure
about the meaning of an icon, just move the mouse pointer over it.
A brief explanation of the icon will appear at the bottom of the
window.

Viewing DMI Component Information

Using mouse button 1, double-click on the DMI component that you
want to open. This will open the Component Information window.

When you are finished, select Close to close the Component
Information window.



Viewing Group Information
To view information about one of a DMI component’s individual
groups:

1. Using mouse button 1, click on the plus sign (+) beside the DMI
component that contains the group data that you want to view.

2. Using mouse button 1, double-click on the name of the group
that you want to view. This will open a window that contains a
list of the group’s attributes.

Viewing Attribute Information

To view information about one attribute of a single group:

1. Using mouse button 1, click on the plus sign (+) beside the DMI
component that contains the group data that you want to view.

2. Using mouse button 1, double-click on the name of the group
that you want to view. This will open a window that contains a
list of the group’s attributes.

3. Using mouse button 1, double-click on the name of the attribute
that you want to view. This will open the Attribute Information
window.

Changing Attribute Information

You can configure attributes that have Access values of Read-Write
or Write Only. To change attribute information:

1. Using mouse button 1, double-click on the specific attribute that
you want to change. This will open the Attribute information
window.

2. Enter the new Attribute information. Note that not all Attribute
information items can be changed.

3. Select Apply to change the attribute information.

If you decide not to make a change, select Reset to restore the
attribute information to its last-saved value.

Select Cancel to close this window without saving any changes.
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Receiving Notification of Problems or Errors

Upon request, the Service Layer notifies management applications of
the occurrence of a problem or error. These problem and error
messages are called events. The events are then stored in the Event
Log, where they can be examined later to help rectify the problem
or error.

The DMI Browser service automatically receives notification of DMI
component events from the DMI Service Layer. If an event message
is received by the DMI Browser service, a telephone object appears
in the DMI Browser icon bar. Select the telephone icon (or select
View event log... from the Options pull-down menu) to open the
DMI Browser Event Log.



ECC Memory Setup

You can use the Netfinity ECC Memory Setup to monitor and
manage ECC memory. Options are:

¢ Single-Bit Error Scrubbing
¢ Single-Bit Error Counting
¢ Single-Bit Error Threshold Nonmaskable Interrupt (NMI)

L] ECC Memory Setup - Another Systen E £l

[_] Single-bit Error Scrubbing
[+ Single-bit Error Counting
[_| Single-bit Error Threshold NI

Single-bit Error Count: ||] Z
Single-bit Error Threshold: |251 Z

Address of Last Error: 0000000

| Save ||Eeset| Help ‘ Exit |

Figure 34. ECC Memory Setup

To configure the ECC Memory Setup:
1. Select the actions that you want ECC Memory Setup to perform.

e Activate the Single-Bit Error Scrubbing option to
automatically correct any single-bit errors that might occur.
Selecting this option might cause slight performance delays
on some systems, but ensures greater data integrity. Check
your system documentation for more information.

¢ Activate the Single-Bit Error Counting option to keep a
running count of all ECC memory errors that occur.

¢ Activate the Single-Bit Error Threshold NMI option to cause
a nonmaskable interrupt (NMI) if the number of single-bit
errors exceeds the user-specified threshold.

Note: If an NMI occurs, it might halt your system.
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2. Change the Single-Bit Error Count, if desired.

The Single-Bit Error Count field displays the number of
single-bit errors that have been detected by the ECC Memory
Setup during the current session.

Note: The single-bit error count is for the current session only.
The count is reset to 0 when the computer is restarted.
To carry a count over from a previous session, you must
enter the error count manually from the configuration
screen.

. Set a Single-Bit Error Threshold value if you have chosen the

Single-Bit Error Threshold NMI option.

The Single-Bit Error Threshold field displays the number of
ECC single-bit errors that will be allowed before a nonmaskable
interrupt (NMI) will be triggered.

Note: An NMI will occur only if the Single-Bit Threshold NMI
option is activated.

. Select Save when you are satisfied with the selections you have

made.

. Select Exit when you have finished configuring ECC Memory

Setup.



Event Scheduler

You can use the Event Scheduler service to easily automate many
hardware systems-management tasks. Use the Event Scheduler to
create scheduled events, execute these events automatically on
multiple remote systems or entire system groups, and maintain
detailed logs of the results of these scheduled events. You can also
edit or delete previously created scheduled events as necessary.

With Event Scheduler, you can create scheduled events that will
automatically perform one of the following tasks on one or more
individual systems, or even on entire system groups:

e Use the System Information Tool to gather data from all
specified systems, and then:

— Save the information as a History File.
— Print the information to a printer or save it to a file.
— Export the data to a Netfinity database.

¢ Distribute files and directories among local and remote systems,
or delete files locally and remotely.

e Execute commands on remote systems.
e Access and manage the System Partitions of remote systems.

¢ Use the Software Inventory service to gather data from all
specified systems and then:

— Save the gathered information to a file.
— Export the gathered information to a Netfinity database.

e Export System Monitor data to a Netfinity database.

e Configure Netfinity services on remote systems using SCF files
(created using Service Configuration Manager).

e Scrub RAID drives on remote RAID systems
e Start up, shut down, or power down remote systems

¢ Use Netfinity command-line interfaces on multiple remote
systems

¢ Automatically generate Capacity Management reports

A scheduled event can be configured to execute repeatedly at a
specified time interval (hourly, daily, weekly, monthly, or yearly)
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for fully automated systems-management functions (such as
simplified hardware inventorying), or can be executed once only for
special situations (such as data collection and distribution or System
Partition updating). Finally, Event Scheduler maintains a detailed
log of all scheduled event results, so you can verify that your
automated tasks were executed correctly.
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Figure 35. The Event Scheduler Service window

Use Event Scheduler to perform any of the following actions:

Create a new scheduled event.

Delete a previously created scheduled event.
View a previously created scheduled event.
Edit a previously created scheduled event.
Refresh the Scheduled Event list.

View the Scheduler Log.

Check the status of currently configured scheduled events.

Select Help to access the Event Scheduler online helps.

Select Exit from the Event Scheduler Service window to close the
Event Scheduler Service window and return to the Netfinity Service
Manager.



Creating a New Scheduled Event

To create a new scheduled event:

1. Select New to open the Schedule New Event window (see

Figure 36).

@ Schedule Hew Event =

New event name:

Tasks:

Schedule by: ———

Command Line Interface

File Transfer
Export Monitors to Database
Synchronize All RAID Drives
Start- up/ Shutdown Systems
Remote Session
Service Configuration
Software Inventory
System Information Tool
System Partition Access

[ Groups

systems

Cancel

Help

Figure 36. The Schedule New Event window

2. Type in the New event name field a name for the scheduled

event.
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3. Select the action to be performed by the scheduled event from

the Tasks selection list. The available tasks are:
¢ File Transfer

Select File Transfer to automatically transfer files or
directories between the local and remote systems, or to
automatically delete files locally or remotely.

¢ Remote Session

Select Remote Session to automatically execute a command
on all selected systems.

e System Information Tool

Select System Information Tool to gather hardware and
configuration data from all selected remote systems. This
data can be saved as a History File, printed to a printer,
saved to a file, exported to a Netfinity database, or saved as
a database file.

e System Partition Access

Select System Partition Access to automatically manage the
System Partitions of all selected systems.

e Software Inventory

Select Software Inventory to gather data about the software
that is installed on the selected remote systems. This data
can be used to generate a simple summary of software
installed on your networked systems or to generate a

detailed report of what software is installed on each selected
remote system. All data gathered by the Software Inventory

service can also be automatically exported to a Netfinity
database.

¢ Monitor Database

Select Monitor Database to export to a Netfinity database
the data gathered by the System Monitors.

e Scrub All RAID Drives

Select Scrub All RAID Drives to automatically scrub the
RAID drive array on any RAID systems.



e Start Up/Shut Down Systems

Select Start Up/Shut Down Systems to attempt to restart,
shut down, power down, or power up remote systems.

Note: Some of these functions will work only on systems
that have hardware or operating system support for
these features.

¢ Service Configuration

Select Service Configuration to use SCF files (created with
Service Configuration Manager) to update or replace the
configuration of specified Netfinity services on remote
systems. For more information about SCF files and Service
Configuration Manager, see “Service Configuration
Manager” on page 261.

¢ Command Line Interface

Select Command Line Interface to use one of the Netfinity
command line interfaces toperform systems management
tasks on one or more systems. For more information on
Netfinity command-line interfaces, see Netfinity Manager
Command Reference.

4. Select Groups or Systems:

¢ Select Groups to perform the selected task on entire System
Groups.

¢ Select System to perform the selected task on individual
systems.

Selecting either of these buttons opens the Schedule Groups or
Systems window (see Figure 37 on page 118).
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(@] schedule Groups or Systems [z |

Groups:

NetBIOS Systems
NetWare Systems

05/2 Systems
Rack #1

Rack #H2
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Schedule | | Cancel | | Help |

Figure 37. The Schedule Groups or Systems window

5. Select from the appropriate fields the system groups or systems
on which the scheduled event will be performed. Then, select
Schedule to save this information and open the task-specific

window.

The task-specific window that opens when you select Schedule
depends upon the task that you selected in step 3 on page 116.
Each of the task-specific windows is covered in greater detail at

the end of this section.

If you need help with the File Transfer task-specific

window, see “The File Transfer Task-Specific Window” on

page 121.

If you need help with the Remote Session task-specific
window, see “The Remote Session Task-Specific Window”

on page 123.



¢ If you need help with the System Information Tool
task-specific windows, see “The System Information Tool
Task-Specific Windows” on page 123.

¢ If you need help with the System Partition task-specific
window, see “The System Partition Access Task-Specific
Window” on page 128.

¢ If you need help with the Software Inventory task-specific
window, see “The Software Inventory Task-Specific
Window” on page 134.

¢ If you need help with the Monitor Database task-specific
window, see “The System Monitor Task-Specific Window”
on page 139.

¢ If you need help with the Start Up/Shut Down Systems
task-specific window, see “The Start Up/Shut Down System
Task Specific Window” on page 141.

¢ If you need help with the Service Configuration task-specific
window, see “The Service Configuration Task Specific
Window” on page 142.

¢ If you need help with the Command Line Interface
task-specific window, see “The Command Line Interface
Task Specific Window” on page 143.

¢ If you need help with the Capacity Management
task-specific window, see “The Capacity Management Task
Specific Window” on page 143.

There is no task-specific window for the Scrub All RAID Drives
task.

. Enter any information required by the specific task that will be
performed by the scheduled event. Then, select Save to save
this information, close the task-specific window, and open the
Schedule Time and Date window (see Figure 38 on page 120).
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Figure 38. The Schedule Date and Time window

7. Use the Schedule Frequency buttons and Schedule Date and

Time field group to configure time intervals and date- and time-
specific settings for the scheduled event.

The Schedule Frequency button group contains six radio
buttons, each of which determines the time interval between
executions of the scheduled event. The available selections are:

e One-Time
e Hourly
¢ Daily

e Weekly
¢ Monthly
e Yearly

Note: As you select a button, only the fields necessary for
proper configuration of this time interval remain active.

The Schedule Date and Time field group contains fields that
enable you to set date- and time-specific information that, when
combined with your selected Schedule Frequency, will
determine the dates and times at which the scheduled event will
be executed. The fields that are active depend on which
Schedule Frequency you have selected. Each field offers a
wildcard value, marked with an asterisk (*). If you select this



value, the Schedule Date and Time information is created for
you, based on the current date and time.

Note: As you alter the Schedule Date and Time values, the
N